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ABSTRACT

A Tool to Analyze Environmental Impacts of Roads on Forest Watersheds

by

Ajay Prasad, Master of Science
Utah State University, 2007

Major Professor: Dr. David G. Tarboton
Department: Civil and Environmental Engineering

Forest roads have impacts on geomorphic processes and erosion patterns in
forested basins. To analyze these impacts the USDA Forest Service (USFS) has
developed a detailed road inventory using Global Positioning System road surveys.
This project has developed a set of GIS tools to derive environmental impact
information from this inventory. A database schema was developed to represent the
road inventory in a structured way. Filtering of the data during entry into the
database serves as a quality control step. The first analysis function in the GIS tool
set calculates the sediment production for each road segment from slope, length, road
surface condition and flow path vegetation. Road segment sediment production is
then accumulated at each drain point. Digital elevation model (DEM) derived
overland flow directions are then used to accumulate the sediment input to each
stream segment. The second function analyzes the impact of road drainage on terrain
stability by calculating the specific discharge due to road drainage and using this,

together with slope, as inputs to an infinite plane slope stability model. An erosion



iii
sensitivity index calculated using slope and contributing road length at each drain
point is also calculated to predict gullying. The final function analyzes the
fragmentation of stream network fish habitat due to potential blockage of fish passage
at stream crossings. The new model was compared with present USFS roads analyses
methods and found that the detailed information in the new road inventory allowed
more specific association of road segments producing sediment with streams to which
they were connected, providing for better calculations of stream sediment inputs.
Comparison of indicators of the potential for gully formation from USFS roads
analyses with surveyed drain points where gullies were observed found that terrain
slope and an erosion sensitivity index that combines slope with the length of road
draining to a drain point were good predictors of gully formation, with the erosion
sensitivity index that relied on additional information from the road inventory survey
having a greater capability for discriminating drain points with a high potential for
gully formation.

(219 pages)
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Preferred values tables

The preferred values group of tables holds the valid or preferred values for each
attribute of a drain point or road line. Each preferred value for each attribute is assigned a
unique integer identifier and these tables list the physical quantity, class or condition
associated with each identifier. Preferred values tables are listed in Tables 4-2, 4-3 and
4-4. These are categorized as applying to drain points, road lines, or common to both; the
VehicleDefinitions table is common to both drain points and road lines. Appendix 2
gives the contents of these tables. Figure 4-2 gives the part of the schema depicting the
relationship between a drain point attribute table (in this example, the DitchReliefAtt
table) and its preferred values tables. Figure 4-3 gives the part of the schema depicting

the relationship between RoadLines and the Road Line preferred values tables.

Table 4-2. Drain Point preferred values tables

Table Name Description
BlockTypeDefinitions Stream crossing blockage conditions (e.g. Organic
Debris Pile)

BroadBaseDipCondDefinitions | Broad Base Dip conditions (e.g. Puddles on road)

BroadBaseDipTypeDefinitions | Broad Base Dip types (e.g. Flat Ditch)

ChannelAngleDefinitions Channel Angle classes (e.g. <25 degrees)

DebrisFlowDefinitions Indicator for presence of Debris Flow at stream crossing
(e.g. Yes/No)

DischargeToDefinitions Indicator of what drain point discharges to (e.g. Gully)

DitchReliefCondDefinitions Gives the condition of Ditch Relief drain points (e.g.
Partially Crushed)

DitchReliefTypeDefinitions Gives the type of pipe used at Ditch Relief drain points
(e.g. ALM (Aluminum)

DiversionDefinitions Gives the number of directions in which flow is
diverted at a stream crossing.

DrainPointTypeDefinitions Gives the type of each drain point (e.g. Broad base dip)
and name of type specific attribute table (e.g:
BroadBaseDipAtt).

FillErosionDefinitions Indicator of the presence or absence of erosion of road

fill at a drain point (e.g. Yes/No)




Table 4-2 continued

33

FlowDiffuserDefinitions

Ditch relief drain point flow diffuser type. (e.g. Half
Pipe Fabric)

FlowDiversionDefinitions

Indicator of the presence or absence of flow diversion at
a ditch relief drain point. (e.g. Yes/No/Unknown)

LeadOffCondDefinitions

Condition of lead off drain point (e.g. Gullied)

MaterialDefinitions

Road surface material at a broad based dip. (e.g. Native
Soil)

NonEngCondDefinitions

Condition of non-engineered drain point (e.g. Diverted
wheel track)

ObstructionDefinitions

Indication of the degree of obstruction at a drain point
(e.g. None/Moderate/Abundant)

PipeDimDefinitions

Stream crossing pipe size class (e,g: 12 for 12 inch
round pipe or 13X17 for oval pipe 13 inches x 17
inches)

PipeNumberDefinitions

Number of pipes used at a stream crossing. (e.g. 1)

SizeDefinitions

Ditch relief drain point pipe size (e.g. > 24")

SlopeShapeDefinitions

Shape of the slope to which a drain point discharges.
(e.g. Concave)

StreamConnectDefinitions

Indicator of whether drain point discharges directly to a
stream. (e.g. Yes/No)

StrXingCondDefinitions

Condition of stream crossing culvert/pipe. (e.g. Totally
crushed)

StrXingTypeDefinitions

Type of stream crossing. (e.g. Steel culvert round or
Natural ford)

SubstrateDefinitions

Substrate material at a stream crossing. (e.g. Sand)

SumpCondDefinitions

Condition of sump drain point. (e.g. Fill saturation)

WaterBarCondDefinitions

Condition of a waterbar drain point. (e.g. Wheel track
damage)

WaterBarTypeDefinitions

Material used for waterbar construction. (e.g. Road
material or Fabricated material)

Table 4-3. Road Lines preferred values tables

Table Name

Description

EdgeConditionDefinitions

Condition of the road cut or fill slope, repeated for
each side of the road. (e.g. Badly rilled)

EdgeVegetationDefinitions

Density classes for road side vegetation, repeated for
each side of the road. (e.g. > 75%)
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FillChannelDefinitions

Distance classes from fill slope toe to channel edge
(ft). (e.g. 1-20,[20])

FlowPathCondDefinitions

Condition of road side flow path, repeated for each
side of the road. (e.g. Rutted)

FlowPathDefinitions

Types of road side flow path, repeated for each side
of the road. (e.g. Wheel tracks or Base of cut)

FlowPathVegDefinitions

Density classes for vegetation in road side flow path,
repeated for each road side (e.g. > 75%). This table
also holds the multiplier used to adjust road segment
sediment production based on road side flow path
vegetation. (e.g. 0.14 for >25% vegetation)

RoadEdgeDefinitions

Road edge cutslope height or fill feature categories,
repeated for each road side. (e.g. 0' no ditch, fill or 6'
to 18' cutslope height)

RoadNetworkDefinitions

Table containing the road network's base erosion rate
parameter used to calculate sediment production. A
default is provided but if a specific road network
requires a different base rate, additional records
should be added to this table.

RoadTypeDefinitions

The type of the road. (e.g. System road)

SurfaceConditionDefinitions

Road surface condition. (e.g. Rilled/eroded)

SurfaceCoverDefinitions

Categories for density of road surface vegetation
cover. (e.g. >10%)

SurfaceTypeDefinitions

Road surface type. (e.g. Paved or Herbaceous Veg.)
This table also holds the surface multiplier which is
used in calculating sediment production (e.g. 0.2 for
paved or 1 for Herbaceous Veg)

Table 4-4. Common preferred values tables

VehicleDefinitions

Vehicle used to conduct the road survey. (e.g. Survey
Truck).
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General information tables

Table 4-5 lists a group of utility tables used for database management and the
recording of errors that occur during pre-processing. Appendix 2 lists the fields in each

of these tables.

DitchReliefTypeDefinitions

Dtchitebef TypelD
DitchR eliefTypeMames
| Drescripkion

DitchReliefCondDefinitions
DitchRebefConditionID

Condition

Description

Discharge ToDefinitions

DischargeTolD
DischargeTo
Description

FlowDiffuserDefinitions

FowDiffuserlD
FlowDiffuser
Description

SizelDl
PipeLength
DitchR elief TypelD
DitchR elief ConditionID
Slopeshapell
DischargeTolD
FillErosionID
| ObstructionID
FlowDiversionID
|FlowDiffuserID

SizeDefinitions

SzelD
DSize
Descripkion

SlopeShapeDefinitions

SlopeshapelD
Slopeshape
Descripkion

FillErosionDefinitions

FilErosionID
FillErosion
Descripkion

ObstructionDefinitions
ObstrudionID

Cbstruction

Description

FlowDiversionDefinitions

FlowDiversiondD
FlowDiversion
Description

Schema representing the relationship between the Ditch Relief attributes
table and its preferred values tables.

Figure 4-2.

GRAIP Database Preprocessor

The database preprocessor tool was developed using Visual Basic 6.0, Visual C++

and Structure Query Language (SQL) that is used to query, edit and add records to the
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database. During preprocessing, unique identifiers are assigned to each drain point and

road line to eliminate ambiguity in data retrieval.
The GRAIP Database Preprocessor Tool imports the existing shapefile attributes,
created by the USFS from the road survey, into a MS Access database. The USFS road

inventory dataset contains a set of drain point and road line shapefiles. These, together

SurfaceConditienDefinitions

SurfaceConditionID
SurfaceCondition
Description

SurfaceCoverDefinitions

arfaceCoverlD
SurfaceCover
Description

EdgeVepgetationDefinitions

EdoeYegetationlD
Edgedegetation
Descripkion

EdgeConditionDefinitions

EdgeCondibonID
EdgeCondition
Description

FlowPathCondDefinitions

FowiathCondID
FlowPathZond
Descripkion

FillChannelDefinitions

RoadLines

EdgeCondition1ID
EdgeConditionzI0

FlowPathZond11D
FlowPathiCondz10

StreamiConnecklID
StreamiConnect2ID

RoadTypeDefinitions

| RoadTypelD

RoadType
Description

SurfaceTypeDefinitions

SurfaceTypelD
SurfaceType
Cescription
Mulkiplier

EdgeVeqgetation1ID
EdgevegetationzI

RoadEdgeDefinitions

RoadEdgelD
RoadEdge

Description

FlowPathDefinitions
HowPathID

FlowPath
Descripkion

FlowPathVegDefinitions
FlowPathVeqglD
FlowPathYeg

Descripkion
Multiplier

StreamConnectDefinitions

SreamConnedt D
StreamiZonnection
Description

Figure 4-3.  Schema of relationship between road lines and its preferred values

definition tables.
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slope calculations amplifying uncertainty in the DEM. Therefore we provide a
function for calculating slope over a specified down gradient distance to ameliorate these
effects. The slope at each drain point is stored in Slope field in the DrainPoints table.

Flow concentration due to channelization is an important mechanism in erosion
and sediment transport. Here road drain points are a source of concentrated water flow
and sediment transport. Montgomery (1994) and Istanbulluoglu et al. (2001b) have
related erosion potential to aS*, where a is the specific catchment area, S is slope and
a is an exponent that varies from 1 to 2. The contributing area a is used as a surrogate
geomorphologic measure for discharge. To evaluate the effect of road drainage on
erosion potential, an analogous erosion sensitivity index, ESI, is developed from the
cumulative upslope road length L. draining to each drain point and the slope at the drain
point.

ESI = L.S* (4.8)

Here L. is used as a surrogate measure for the quantity of road drainage and is
obtained from the effective length (ELength) field in the DrainPoints table. The ESI
values are stored in the ESI field in the DrainPoints table.

To compare ESI to observed gullies, a graph is developed with Length L on the
vertical axis and Slope S on the horizontal axis with capability to display lines which
represent low, medium and high ESI areas in the plot area. Information derived from the
discharge to (DischargeTolD) field which contains information on whether the drain
point is discharging to a gully is used to symbolize drain points on the plot. ESI
partitioning lines are drawn to separate the domain into regions that hold approximately

equal numbers of drain points. A statistics table (Table 4-12) is also provided to display
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the distribution of drain points in each ESI class. The table also shows the number of

drain points with observed gullies in each category. This analysis is used to define ESI
ranges where the potential for gully development is high or low, and to identify for

mitigation or treatment drain points with high gully development potential.

Stream Blocking Analysis

The plugging of culverts by organic debris and sediment can result in blocking of
drain points. Flanagan et al. (1998) discuss procedures for assessing the erosional hazards
and risks to aquatic and riparian ecosystems of road stream crossings, ditch relief
culverts, and other road drainage features. Scores representing the probable hazard level
are determined using the culvert diameter to channel width ratio (w*) and the channel
skew angle. Tables 4-13 and 4-14 list hazard scores for each of these from Flanagan et al.
(1998). Calculated hazard scores for W* and channel skew angle are stored respectively in
PipeDiaToChanWidthScore and SkewAngleScore fields in the DrainPoints table. These
scores are added to obtain an index for stream blocking which estimates the plugging
susceptibility of the culvert and the resulting scores are stored in SBI field in the
DrainPoints table.

Table 4-12.  Structure of the ESI statistics table

DischargeTo ESI>=ESIhigh ESIpeqd <= ESI < ESIhigh ESILow<= ESI < ESled

Gullies #

Elsewhere #

Table 4-13. Hazard score for ratio of culvert diameter to channel width (w*)

Culvert diameter/width of channel Hazard score

w* <0.5 3
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0.5<w*<1 2

w* > 1

Table 4-14. Hazard score for channel skew angle values

Skew angle Hazard score
> 45 degree 1

<45 degree or no 0

definable channel

Habitat Segmentation Analysis

Stream crossings in the road network may be a barrier to many species of fish.

Identifying stream crossings which are or can be blocked will help forest managers to

plan for culvert maintenance. Fish passage barriers are identified based on factors like

1.

2.

Stream crossing substrate

Blocked or crushed culvert

Crossing channel gradient

Outlet drop

Pipe to channel width ratio

Sediment and organic debris from roads

The GRAIP habitat segmentation analysis identifies road stream crossings that

block fish passage and causes habitat segmentation. This analysis consists of following

steps:
1.

2.

Locate fish passage barriers — Identifies fish passage barriers.
Demarcate fish habitat clusters — Identifies contiguous stream habitat clusters and

assigns each a unique identifier.
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The algorithm shown in Figure 4-11 was developed, based on examples in

Clarkin et al. (2003), to determine the status of each stream crossing by analyzing the
attributes of the stream crossing drain point. Here Sy is the crossing slope threshold (2%
default), ODp is the outlet drop threshold (0.8 ft default), w*; is the pipe width, PW, to
channel width, CW, ratio threshold (0.75 default) and ODPD is the outlet drop to pool
depth barrier ratio threshold (1.125 default). The resulting stream barrier status is stored
in Barrier field in DrainPoints table. Table 4-15 lists the identifiers used for representing

the status of each stream crossing.

Table 4-15. Barrier information for stream crossing drain points

Barrier Status Value
Completely Blocked | 0
Partial Passage 1
Clear Passage 2
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| Start |

Stream bed Culvert materia Totally
blocked or
crushed or

flows around

Yes

Baffles

Totally

Yes blocked or [ Partial Passage ] No
crushed N
(o}
Slope <8,
Yes

No

No Outlet drop
<OoD,
Yes

No Yes Outlet drop No

[ Partial Passage > QODPD x

pool depth

Yes
Figure 4-11. Fish passage barrier determination.

Once the stream crossings which are fish passage barriers are identified and
assigned a barrier status, stream habitat fragmentation is analyzed. The size and
connectivity of stream habitat clusters is important in assessing the fragmentation of
habitat due to road stream crossing fish passage barriers. Figure 4-12 shows the flow
chart for demarcating habitat clusters in the stream network. The function takes the
TauDEM stream network shapefile segmented at drain points as described earlier (see
section Stream Crossings and Stream Network Delineation), the filtered stream crossings

shapefile (MatchSX.shp) from GRAIP drain points, and the GRAIP drain points shapefile
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(DrainPoints.shp) (see section GRAIP Database Preprocessor) as input. The habitat

segmentation analysis is comprised of following steps:

1.

Create habitat patch identifier field (HabPatchID) in the TauDEM stream network
shapefile

Find each downstream segment in the stream network. There may be multiple
downstream segments due to multiple distinct outlets. The TauDEM stream network
shapefile is scanned to locate a stream segment where the downstream link number
(in DSLINKNO field) is -1. Assign habitat patch identifier as the ID of the stream
segment. These represent the downstream ends or outflows of the drainage network
and are is taken as the starting point for the stream network tracing operation.

Trace upstream: The upstream link is identified from the information in the stream
network attribute table (see Appendix 3).

Get downstream node identifier: The downstream node id (DSNODEID) is identified
from the stream network attribute table.

Find stream crossing with ID corresponding to DSNODEID in the matched stream
crossings shapefile (MatchSX.shp).

For the stream crossing identified in MatchSX find the GRAIPDID.

Check stream crossing status: The GRAIPDID is used to identify the drain point in
the GRAIP drain points shapefile (DrainPoints.shp) and the stream crossing barrier
status is checked.

Assign habitat patch identifer in the stream network: If the stream crossing is blocked
a new habitat cluster is created upstream. The stream segment habitat patch identifier

(HabPatchID) is assigned with the ID of the upstream stream segment. If the stream
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crossing is not blocked the HabPatchID for the downstream segment is assigned to
the upstream segment HabPatchID field. This procedure is continued until all the
upstream links have been traced and assigned with HabPatchIDs.
The result from this procedure is a set of contiguous habitat clusters identified by
the ID of the most downstream stream segment. The tool also provides the user with an

option to treat partially blocked stream crossings as completely blocked.
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Figure 4-12. Algorithm for assigning habitat cluster identifier.
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CHAPTER 5

CASE STUDY

This project contributes to both information science and process science as related
to the cumulative impact of roads on forest ecosystems. In terms of information science I
have addressed the question as to how to formally organize and structure the data that
represents the interaction between roads, drain points, hillslopes and stream networks to
enable and facilitate road impact assessments. These assessments are cumulative across a
number of processes (erosion, landsliding, stream habitat fragmentation) as well as
integrating spatially the local effects at points. In terms of process science I have
implemented a number of process models and packaged them as a set of user friendly
GIS tools. Verifying all these process models against data would be beyond the scope of
what [ am able to do with the data available. Some of the methods have been separately
published and tested by others, so the contribution here is the integration into a single tool
set. The validity of the model relies on the validity of the methods developed and

published by others that have been integrated.

GRAIP Database Preprocessing

The GRAIP Database stores information about road lines, drain points, pre-
defined valid values (preferred values) and relationships between tables. The GRAIP
Database Preprocessor tool (explained in Chapter 4 Section 2) was used to validate and
store the USFS road inventory dataset into the GRAIP Database model. The GRAIP

Database Preprocessor tool was used to take the USFS road inventory data described in
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Chapter 3 as input to create a validated inventory in the form of a GRAIP Database.

The output files listed in Table 5-1 were created for both the full study area and the

subset study area that was used for the habitat segmentation analysis.

Tables DPErrorLog and RDErrorLog store information about the issues found and

actions taken to rectify the issues while importing to the GRAIP Database. For the full

study area, the entries in these tables identified 479 issues related to the drain point

shapefiles and 96 issues related to the road lines shapefile. These issues are categorized in

Tables 5-2 and 5-3. Table 5-4 lists the attributes that were reassigned as recorded in

ValueReassigns table during data preprocessing.

Table 5-1. Output files for GRAIP project called “runl”
File Name Type Description
runl.graip Binary file GRALIP Project File with information about file paths
for DEM, Input and output Shapefiles, GRAIP
Database file and log files. This file is used as input to
GRAIP GIS Model (Explained in next section)
runl.mdb GRAIP MS GRAIP Database which holds attributes of Drain
Access points and road lines
Database file

run1DP.log Text file Contains error logs and action taken for Drain points
file. This file has the similar structure and contains the
same information in DPErrorLog table (see appendix
2)

runlRD.log Text file Contains error logs and action taken for Road lines
file. This file has the similar structure and contains the
same information in RDErrorLog table (see appendix
2)

DrainPoints.shp Shapefile Consolidated drain points file with a unique identifier
field called GRAIPDID which has one to one
relationship with GRAIPDID inside GRAIP Database

RoadLines.shp Shapefile Consolidated drain points file with a unique identifier

field called GRAIPRID which has one to one
relationship with GRAIPRID inside GRAIP Database
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Table 5-2. Drain point issues identified during the preprocessing operation for the full

study area
Issue Type Number of Issues
New value added to preferred value table 2
Reassign attribute to an existing value in preferred values table | 9
Orphan Drain Points (Drain points without any roads draining 321
to it)
Duplicate DRAIN_ID (refer to Appendix 1 drain points 147
structure)

Table 5-3. Road line issues identified during preprocessing operation for the full study
area

Issue Type Number of Issue

New value added to preferred value table 1

Reassign attribute to an existing value in preferred values table | 6

Orphan Road line (Road line not draining to any drain point) 89

Duplicate Road Identifiers 0

Table 5-4.  Reassigned attributes recorded in the ValueReassigns table for the full study area

ID | FromField ToField DefinitionID | DefinitionTable

2 Abundent Abundant 3 ObstructionDefinitions

3 Puddles on road Puddles on road 2 BroadBaseDipCondDefinitions

4 Gulley Gully 2 DischargeToDefinitions

5 Previous Unknown 0 FlowDiversionDefinitions

6 Outsloped Out sloped 6 NonEngCondDefinitions

7 Gully Crosses Road | Gully 4 NonEngCondDefinitions

8 Blocked Ditch Blocked 1 NonEngCondDefinitions

9 2 directions 2 Direction 3 DiversionDefinitions

10 | Steel arch bottomles | Steel arch 3 StrXingTypeDefinitions
bottomless

11 21-50 21-50,[50] 3 FillChannelDefinitions

12 | 0-20 1-20,[20] 2 FillChannelDefinitions

13 | Rd hits channel 0,[1] 1 FillChannelDefinitions

14 [ >110% 110% 1 FlowPathVegDefinitions

15 100 % >T75% 2 FlowPathVegDefinitions

16 | >50" Above 50,[100] 4 FillChannelDefinitions
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These comprise problems such as typographical spelling errors and

inconsistencies in the recording of attributes that were rectified. The issues identified can
also be manually examined and flagged for re-examination in the field if not resolvable
given information at hand.

The GRAIP database preprocessor tool has made it a lot easier than was
previously possible to identify and correct data discrepancies that may have an impact on

the results.

Road Surface Erosion Analysis

The road surface erosion analysis was carried out for the full study area and
sediment production from road segments, drain point sediment accumulation and stream
sediment inputs were calculated. The resulting sediment values for road segments and
drain points were appended to the RoadLines and DrainPoints table in the GRAIP
database (runl.mdb). The stream sediment inputs were appended to the stream network
shapefile attribute table.

The road segment elevation range and length was calculated and appended to the
RoadLines shapefile attribute table. Using this information, sediment produced from each
side of the road segment, unit sediment produced, total sediment produced, total sediment
delivered to the stream network and unit sediment delivered, were calculated and
appended to the RoadLines table. Figure 5-1 shows an excerpt from the RoadLines table

with stored sediment production values



B | Attributes of Roadlines

GRAIPRID SedProd1 | SedProd2? UnitSed TotSedProd | TotSedDel UnitTotSedDel | -~
126 (1910581055 | 19105581055 17819358 | 3821 162109 0 u]
B 127 | 133.056946 | 133.056946 3.999941 266113535392 | 266.113592 3999941
| 128| &1.07186 a1.073186 4524130 | 162156372 1] n
| 120| 128500366 | 1285500366 385594 | 257000732 | 257.000732 3185504
B 130( 196728516 | 196728516 2539927 39345703 39345703 2539927
: 13| 8216308328 | &21.6308359 5§.75853593 | 1643261719 1643.261719 G.7058593 |
£ >
Record: ﬂﬂ 0 ﬂm Show: W Selected | Records [0 out of 2048 Selected ) Optiors =

Figure 5-1. RoadLines table inside GRAIP Database model populated with sediment
production.
A total of 21.7 x 10° kg/yr was calculated to be produced from the 8280 road
segments with total length of 721 km. One thousand nine hundred and sixty six road
segments are calculated to deliver a total sediment load of 4.7 x 10° kg/yr to the stream

system. Figure 5-2 shows the distribution of unit sediment production and unit sediment

delivered.
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Figure 5-2. Number of road segments within each unit sediment production class.
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From the sediment production values calculated for each side of each road
segment and information about the drain points to which each side drains, the
accumulated sediment load, effective length of road, sediment delivered to the stream
network and unit sediment load were calculated at each drain point and appended to the
DrainPoints table. Figure 5-3 shows an excerpt from the DrainPoints table with
corresponding accumulated sediment load values, and Figure 5-4 shows the distribution
of sediment load at drain points.

The accumulated sediment load at each drain point was then used to create a grid
of drain point sediment load values. This grid was used as a weight grid in the TauDEM
D8 contributing area function to create a grid of accumulated upslope road sediment
inputs. Figure 5-5 illustrates the drain point sediment production and accumulated

sediment load grid.

B Attributes of DrainPoints

GRAIPDID* | SedProd | ELength | UnitSed | SedDel |~
2775 | 5108720276 | 113791112 44878024 | 5106720276
2775 | 495844208 | 75569559 6601008 0
2777 (4225757446 | 92362208 45752018 i
2778 |3639.195557 | 42361821 | 90628671 | 3839195557
2779 (1337 609253 | 28836628 | 46385772 i
2750 | 2659969153 | 43221511 | 61.542289 | 2659959153
2781 | 2040037097 | B0.G99101 | 33.498640 0w
b

Record: ﬂﬂ| 1] ﬂﬂ Shnw:lﬁ Selected | Records [0 out

|
|
|
|
|
|
|
<

Figure 5-3.  DrainPoints table in GRAIP database with sediment load values.
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Figure 5-4.  Number of drain points within each unit sediment production value class.

The accumulated and direct sediment inputs to each stream segment were
calculated by intersecting the accumulated sediment load grid and stream network
shapefile and values were appended to the stream network attribute table. Accumulated
and direct specific sediment values were then calculated by dividing the accumulated and
direct sediment values at each stream segment by upstream and direct area draining to
each segment. Figure 5-6 shows an excerpt of the stream network shapefile attribute table
that has appended sediment input values. The total accumulated sediment load to the
stream network calculated for the study area was 20.7 x 107 kg/yr and the direct sediment

input was 5.3 x 107 kg/yr.
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Figure 5-5.  Drain point sediment production and accumulated sediment load grid.
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B Attributes of Stream Metworlk E_I[E|E
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SedDir | SpecSedDir |

| 791 (137351 8125 |  40.326428 | 137351.8125 | 153.204434
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| GG 0 0 a Q

B B25 | £29399.375| 4055931 | 169574375  3.219047 w
£ >

Fecord: ﬂﬂ Dﬂﬂ Shnw:m Selected | Records [0 out of 8¢

Figure 5-6.  Stream network shapefile attribute table with sediment input values.

Mass Wasting Potential Analysis

The impact of road drainage on initiation of landslides and gully formation were
analyzed using SINMAP with and without road drainage modifications, and using the

Erosion Sensitivity Index, ESI.

Terrain stability

SINMAP 2.0 was first run for the study area to get the stability index (SI) grid
without the impact of road drainage. A single calibration region was used with default
parameter settings (Table 5-5 first 9 rows) to develop the SI grid. Using the stability
index grid the SI value at each drain point was found and appended to DrainPoints table
in GRAIP database.

The combined stability index function, accounting for road drainage, was then run
to obtain a grid of SIR values. The default parameters, including the last two rows
pertaining to road drainage, from table 5-8 were used. The combined SI value at each
drain point was appended as the SIR field in the DrainPoints table in the GRAIP

database. Figure 5-7 illustrates the combined SI values.
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Figure 5-7. Combined Stability Index grid.
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Table 5-5. Default SINMAP calibration parameters

Minimum transmissivity 2.708 (m”/hr)
Maximum transmissivity 2.708 (m*/hr)
Minimum cohesion 0 (N/m”)
Maximum cohesion 0.25 (N/m?)
Minimum friction angle (¢min) 30°
Maximum friction angle (Pmax) 45°

Soil Density 2000 (kg/m’)
Minimum terrain recharge 0.0009 (m/hr)
Maximum terrain recharge 0.00135 (m/hr)
Minimum additional road runoff 0.001 (m/hr)
Maximum additional road runoff 0.002 (m/hr)

Erosion sensitivity index

ESI values were calculated for all drain points in the study area. I carried out a
GPS survey to identify road drain points over a 33.5 km stretch of road that had led to the
development of erosion gullies. This stretch of road contained 263 drain points of which
39 were mapped as gullied. The stretch of road surveyed for gullies is shown in Figure 5-
8 and the drain points along this stretch of road were used to examine the relationship
between ESI and gully occurrence.

In evaluating ESI, first the slope at each drain point was calculated. For that a grid
of slope values was created using downslope averaging over a distance of 60 meters in
the direction of D8 flow. The drain points were then intersected with the slope grid and
slope values at each drain point were determined and appended to the Slope field in the
drain points table in the GRAIP database. The ESI values were then calculated using the
slope and the effective length (ELength) of the road draining to each drain point. A value
of 2 was used for a.. The drain point slope and the effective length of the road draining to

each drain point were plotted (Figure 5-9). Observed gullies were identified and
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symbolized in the plot. ESI class thresholds were chosen to define regions that hold

approximately an equal number of drain points in each class. The threshold values of ESI
obtained in this manner were 1.25, 8 and 25 for low, medium and high values

respectively.

Legend
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Figure 5-8.  Subset of drain points used for ESI analyses along road specifically
surveyed for gullies.



Table 5-6 shows the classification of ESI values inside each class. The observed
percentage of gullies is seen to be higher in higher ESI classes indicating a direct
relationship between ESI and gullying. These curves discriminate the drain points

according to the potential for gully formation.
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Figure 5-9.  Length-Slope graph with ESI threshold lines plotted.

Table 5-6.  Classification of gullies inside each ESI class

ESI Value | Number of Drain Number of Percentage of %
Index | Class Points Gullies Gullies
1 <1.25 81 4 4.94
2 1.25-8 64 3 4.69
3 8-25 63 18 28.57
4 25< 55 14 25.45
Total 263 39 14.83
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Stream blocking index

The next step is to estimate the stream blocking index (SBI) as the additive hazard
score for culvert plugging susceptibility. This was calculated by dividing the culvert
diameter by channel width. Culvert dimension and channel width information was
obtained from the drain point attribute tables and the resulting hazard score (Table 4-11)
values were appended to the drain points attribute table in the field
PipeDiaToChanWidthScore. The channel skew angle was also examined and
corresponding hazard scores were appended in SkewAngleScore field in the drain points
table. The SBI is the sum of PipeDiaToChanWidthScore and SkewAngleScore. The SBI
values were then added to the SBI field in the drain points table. Figure 5-10 displays a

partial listing of the calculated hazard scores in the drain points table.

Habitat Segmentation Analysis

Habitat segmentation analysis was carried out for the 303 km? subset of the study
area described in Chapter 3. To prepare for this analysis the stream crossing drain points
were preprocessed and stream crossings which were beyond the distance threshold (100
m) or had channel width inconsistent with the contributing area at that point were filtered
out using the methods described in Chapter 4. The tool automatically matched 33 stream
crossings which passed both distance threshold criteria of 100 meters and channel width
criteria as shown in equation 4.2. Figure 5-11 presents an example of this filtering
process that derived matched stream crossings (MatchSX.shp) from surveyed stream
crossings (StrXingEx.shp). The stream crossing with GRAIPDID 674 was eliminated

because there was no stream near to the drain point. Even if there is a stream crossing at
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GRAIPDID 674 as surveyed, this is unlikely to be a factor in the fish habitat

fragmentation analysis. This should be further verified by field crew if necessary. The
surveyed stream crossing with GRAIPDID 675 has a stream near to it and two candidates
on stream locations that it matches, one each from snapping and the road stream
intersections. Both of these pass the criteria of being closer than the distance threshold
(100 m) and having geomorphologically estimated channel width consistent with the
surveyed channel width. The snapped point, which is nearer, was flagged as the on
stream location for GRAIPDID 675 and written to the MatchSX.shp file while the road
stream intersection with GRAIPDID 675 in StrXingRi.shp was eliminated. Table 5-7
lists the stream crossings which passed both criteria. The filtered stream crossings were
appended to the outlets file to create a new stream crossings + outlets shapefile which
was used to delineate a new TauDEM stream network that was segmented at each stream
crossing.

The first step in Habitat Segmentation Analysis was identification of drain points
that are barriers to fish passage. The DrainPoints shapefile was taken as input to find
and assign each drain point its fish passage status, (fully blocked, 0, partially blocked, 1
or clear passage, 2). This information was stored in the DrainPoints table Barrier field.
Default parameters listed in Table 5-8 were used to calculate the fish passage barriers

following the algorithm in Figure 4-11.
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Table 5-7. Matching stream crossings attribute table
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ID | RSAMDID | CHAN WDTH | PType Distance | CArea GeoCW
4 616 5 | Snapped 489 33x10° 3.04
5 617 5 | Snapped 12.02 | 8.7x10° 451
6 618 6 | Snapped 25.68 | 8.7x 10° 4.5

13 625 2 | Snapped 1.62 | 3.8x10° 3.24
14 626 3 | Snapped 18.55 | 1.1x 10° 4.87
15 627 2 | Snapped 18.85 | 2.2x 10° 2.6
16 628 10 | Snapped 10.13 | 1.4x 10’ 13.86
17 629 3 | Snapped 0.03 | 5.6x10° 3.78
18 630 2 | Snapped 431 3.5x10° 3.11
26 638 2 | Snapped 8.1]23x10° 2.61
32 644 12 | Snapped 13.5] 6.0x 10° 9.82
33 645 8 | Snapped 433 ] 6.9x10° 10.41
39 651 2 | Snapped 48.02 | 2.8x10° 2.85
42 654 5 | Snapped 2149 | 9.0x 10° 4.57
43 655 8 | Snapped 1047 | 1.7x 10° 5.84
44 656 12 | Snapped 0.1 1.8x10’ 15.23
45 657 3 | Snapped 6.93 | 2.7x10° 2.79
51 663 4 | Snapped 7.68 | 1.1x 10° 491
54 666 3 | Snapped 022 3.6x10° 3.14
55 667 2 | Snapped 2.19| 2.8x 10° 2.84
63 675 6 | Snapped 13.36 | 42x10° 8.53
65 677 3 | Snapped 472 62x10° 3.93
68 680 5 | Snapped 2.62 | 49x10° 3.58
69 681 5 | Snapped 13.13 | 4.6x10° 3.48
70 682 4 | Snapped 7448 | 22x10° 2.59
73 685 3 | Snapped 299 3.2x10° 2.99
76 688 2 | Snapped 11.54 | 3.8x 10° 3.22
80 692 2 | Snapped 6.81  4.0x10° 3.3
81 693 4 | Snapped 1.01 | 7.3x 10° 4.21
86 698 8 | Snapped 59 8.1x10° 11.1
87 699 12 | Snapped 12.74 | 3.5x 10’ 19.96
118 640 6 | Road Stream Xing 29.24 | 1.9x 10° 6.19
124 648 4 | Road Stream Xing 2047 | 3.0x 10° 291
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Table 5-8. Default parameters for fish passage barrier determination.

Parameter Name Value
Crossing Slope - S, 2%
Outlet Drop - OD, 0.8 feet
Pipe to Channel Width ratio — w*; 0.75
Outlet Drop to Pool Depth ratio- ODPD | 1.125

Three out of 88 stream crossings were classified as completely blocked and 13
stream crossings were classified as partially blocked. Out of the 33 stream crossings
identified during the filtering process and matched with on stream points, two stream
crossings, with GRAIPDID 628 and 651 were completely blocked and five stream
crossings, with GRAIPDID 617, 618, 644, 645 and 648 were partially blocked. Fish
habitat clusters were then identified by using the fish barrier information and tracing
through the stream network to demarcate the clusters. Inputs to this function were the
TauDEM created stream network file, the stream crossing drain point file used as outlets
shapefile in the TauDEM network delineation function, and the GRAIP Drain Points file.
Habitat clusters were identified using both partially blocked and completely blocked
stream crossings as barriers. The resulting habitat cluster or patch identifiers were
appended to the shapefile attribute table as shown in Figure 5-12. Figure 5-13 illustrates

contiguous habitat clusters due to blocked stream crossings.
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Figure 5-12.  Habitat patch identifiers appended to stream network attribute table.
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CHAPTER 6

MODEL COMPARISON

Introduction

An important question, in the context of the inventory and analysis procedures
discussed in earlier chapters, is how much more information is gained from inventorying
and analyzing both the road lines and the drain points over simply knowing where the
road lines are. The USFS Roads Analysis methodology (Bisson et al., 1999) combines
the roads line coverage obtained from land management agencies and the DEM to
estimate the impacts of forest roads on watersheds. Wold and Dubé¢ (1998) and Luce and
Wemple (2001) explain the potential importance of knowing more information about
road attributes for better evaluating sediment production and delivery from road
segments. Black and Luce (2002) describe the benefits of making a comprehensive
inventory of forest roads and analysis of that inventory as part of watershed analysis.
Their inventory focuses on questions like, “Where are runoff and sediment generated or
intercepted by roads, and where do the water and sediment travel?”” The inventory
comprises a detailed GPS survey of road and drain point attributes such as the location of
culverts and presence of mass wasting sites like gullies or land slides. The GRAIP model
is based on Black and Luce (2002) and takes input from the inventory.

The objective of this section is to quantify the incremental value of road analysis
based on a GPS road survey as proposed by Black and Luce (2002) that includes detailed
attributes of roads and drain points (such as road ditch vegetation type, culvert pipe

dimensions, drain point discharge location) for estimating road sediment production and
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impacts of road drainage on erosion and mass wasting. This section first compares the
road sediment production and delivery to streams as calculated by the BOISED Model
(Reignig et al., 1991) which uses just the road lines shapefile with a GRAIP road
inventory and analysis for the South Fork of Payette River in the Boise National Forest.
This section then evaluates the GRAIP erosion sensitivity index and indicators from the
USFS Roads Analysis (Bisson et al., 1999) that are intended to be predictors of gullying
by comparing them to observed gully locations. The comparison also shows how each

analysis method can better inform forest road management decision making.

Study Area

Figure 6-1 shows the road network used in the sediment production and stream
sediment delivery comparison of BOISED with GRAIP. Figure 6-2 shows the six-digit
Hydrologic Unit Code (HUC) Watersheds within the study area that were used to
aggregate the sediment production values used in some of the model comparisons. Figure
6.3 shows the subset of the study area used to evaluate the effectiveness of gullying
indicators. Along this stretch of road 263 drain points were inspected for the occurrence

of gullying and 39 were found to have gullies.
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Figure 6-2. Six-digit Hydrologic Unit Code (HUC) watersheds for the South Fork of the

Payette River, Boise National Forest, Idaho.
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Figure 6-3. The subset area, used in gully initiation risk, illustrates the road segments,
drain points and stream network.

Methods

Sediment production

This section explains the calculations involved in estimating the road sediment
production and stream sediment delivery using BOISED (Reignig et al., 1991) and

GRAIP models.



95

BOISED road surface erosion analysis. BOISED is one of several models used

for estimating sediment production and delivery from land management operations that
were derived from the R1/R4 Guide for Predicting Sediment Yield from Forested
Watersheds (Cline et al, 1984). The model estimates the sediment production based on
road age, gradient, mitigation techniques, and the “landtype” the segment crosses.
Landtypes are derived from geomorphic and geologic classification of terrain (Arnold,
Arnold and Associates, and Dames and Moore, 1975). For example canyon breaklands
would be one classification with a distinct difference from periglacial uplands or alluvial
stream bottoms. Each landtype is assigned characteristic quantitative features, such as
slope and drainage distance, which are then used to estimate critical parameters of the
BOISED model, e.g. side slope, geologic erosion factor, and sediment delivery ratio (see
Appendix 6 for example values). Values for typical landtype characteristics are assigned
somewhat subjectively by a group of experienced watershed specialists (Arnold, Arnold
and Associates, and Dames and Moore, 1975).

The BOISED model calculates the total erosion from a uniform road segment

within one land type as:

Er = BERr * DA * GEF * GF * MF (6.1)
BERar = BER * AF (6.2)
SD = SDR*Er (6.3)

where Er is the sediment production, BERar is the base erosion rate adjusted for
vegetation age factor, BER is the base erosion rate per year (Reignig et al., 1991), AF is
the BOISED age factor calculated from decay of the base erosion rate (Reignig et al.,

1991) with age, DA is the disturbed area, GEF is the geologic erosion factor, GF is the
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road gradient factor, MF is the mitigation factor, SDR is the sediment delivery ratio

and SD is the sediment delivery to streams. Following are the steps in the sediment

production calculation for the BOISED model.

1. Calculate Base Erosion Rate with age factor (BERar) for BOISED: The base
erosion rate (BER) was assumed as 67500 tons/miz/yr (Reignig et al., 1991) or
23.7 kg/m?/yr for an average 6% sustained grade, 50% side slope and native road
surface type. Table 6-1 lists the age factors calculated based on the decay of base
erosion rate with years since road was open to traffic (Reignig et al., 1991). The
age factor for each age of the road is the ratio of the base erosion rate for that age
and the base erosion rate for year one i.e. 67500 tons/mi*/yr. In the current
application the years since the road was open to traffic is not known but we do
have information on the percentage of vegetation coverage in flow paths on each
side of the road. The 4™ column of Table 6-1 gives the mapping between flow
path vegetation and age factor that was assumed, with AF being taken as the
average of the two AF values from column 3 corresponding to the flow path
vegetation in column 4.
2. Calculate the disturbed area: Road widths were adjusted based on the average

side slope of the landtype on which the road was constructed. Appendix 6 gives
the list of side slope values for each landtype obtained from Reignig et al. (1991).
The default road tread width used in this model was taken as 4 meters (Reignig et
al., 1991). Equation 6.4 shows the formula for default disturbed width derived
from the relation between disturbed road width and side slope gradient (Reignig et

al., 1991).
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dw=b + b * 0.0006 * (Side Slope Gradient)? (6.4)

Here dw is the disturbed width and b is the default road tread width. Appendix
6 lists the default disturbed width for each side slope gradient calculated from
this formula, where the side slope gradient is assigned by landtype.

. Calculate road length: The Road Surface Erosion Analysis tool in GRAIP was
used to calculate the road segment length.

. Get geologic erosion factor (GEF): Information from Reignig et al. (1991) about
GEF for each land type (Appendix 6) was used.

. Estimate road surface mitigation factor (MF): The MF for each road segment was
calculated using surface type information in the road lines shapefile. Table 6-2
lists the mitigation factor for each surface condition type. The SURF _TYPE field
in road lines table contains the condition of the road surface obtained from the
USFS GPS road survey (Black, and Luce, 2002). Based on the surface type
information, MF for each road segment was calculated and appended to the road
lines shapefile as the “MitiFactor” field.

. Calculate road gradient factor (GF): The GF is a function of the slope of each
road segment calculated as the elevation range divided by road length. Elevation
range and road length for each road segment were calculated using the GRAIP
Road Surface Erosion Analysis function. GF for each road segment was then
obtained from Table 6-3 (Reignig et al., 1991).

. The sediment delivery ratio (SDR) was obtained based on land type class
(Appendix 6) and was multiplied with Er to calculate sediment delivery from each

road segment to streams.
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Table 6-1. Relationship of base road erosion rate and age factor with year since activity
(Reignig et al., 1991)

Years since open | BERsr | Age Factor (AF) Road Flow Path Vegetation
to traffic

1 67500 1 0%

2 18000 0.26 >10%

3 5000 0.07 >25%

4 5000 0.07 >50%

5 5000 0.07 >75%

6+ 5000 0.07 >75%

Table 6-2. BOISED mitigation factor

Surface Type Mitigation Factor
Crushed rock 0.2

Native 1

Paved 0.05

Herbaceous Vegetation | 0.2
Trees > 4 inch diameter | 0.2

Table 6-3. BOISED road gradient factor

Gradient (%) Road Gradient Factor
<5 0.5
5-9.9 1.0
> 10 1.5

GRAIP road surface erosion analysis. The GRAIP Road Surface Erosion

Analysis function calculates the road sediment production and sediment delivery at each
drain point. The sediment produced from each road segment was calculated following

Luce and Black (1999)

E _ aLSrv

= (6.5)
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where L is the road segment length, S is the slope of the road segment, a is the annual
base erosion rate, r is the road surface multiplier (Table 6-4), v is the vegetation
multiplier (Table 6-5) based on ditch vegetation and i indicates the side of the road.
Information for these multipliers were taken from Luce and Black (2001a, 2001b) and the
Washington Forest Practices Board (1995) which synthesizes the work of several
scientists.

The formula for sediment production (equation 6.5) was applied separately to
each side of the road because flow paths on opposite sides of the road may drain to
different drain points and have different attributes, hence the division by 2. The base
erosion rate, a, was calculated to make the results consistent with the BOISED erosion
calculations. The BOISED base erosion rate BER of 67,500 tons/m*/yr converts to 23.7
kg/m*/yr for a road with 6% slope, 50% side slope and native surface material (Reignig et
al., 1991). The base erosion rate in GRAIP is per unit of vertical elevation change on a
gravel surface road. This requires some manipulation to estimate an equivalent base rate
so that the “standard” road segment for BOISED (the empirical basis) would produce the
same amount of sediment in either model. Assuming a default road tread width of 4 m,
equation 6.4 gives a disturbed width of 10 m (4 +4 * 0.0006 * (50)%). The GRAIP base
erosion rate parameter is then calculated as

a=BER*dw/(S*r) =23.7*10/(0.06 * 5) =790 kg/m/yr

The multiplication by dw = 10 m accounts for the road tread width. The division
by slope, S, adjusts to per unit elevation change and the division by road surface
multiplier, r=5, adjusts the BER rate which is for a native surface to the GRAIP rate

which is for gravel (Table 6-4).
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This base erosion rate of 790 kg/m/yr was used along with the vegetation and

road surface multiplier and length and slope (elevation range) of the road segment to
estimate the sediment production from forest roads in the GRAIP Road Surface Erosion
Analysis. Before performing the Road Surface Erosion Analysis, the GRAIP database
preprocessor tool was run to validate the USFS road inventory and store it in the GRAIP
database. The preprocessor creates consolidated drain points (DrainPoints.shp) and road
lines (RoadLines.shp) shapefiles. These files and the DEM for the study area were then
taken as inputs to the Road Surface Erosion Analysis. Using the drain point identifier
information (GRAIPDID1 and GRAIPDID?2 representing each side of the road and
explained in Chapter 4) the accumulated sediment load at each drain point was
calculated. Stream connection information for each drain point was then used to estimate

the sediment delivery to streams.

Table 6-4. SurfaceTypeDefinitions table with surface types and multipliers, based on
Washington Forest Practices Board, 1995

Surface Type Multiplier
Default (gravel) | 1
Crushed rock 1
Native

Paved
Herbaceous Veg
Brush

Trees > 4 in Dia
Cinder

—t [ [ (= | D | N
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Table 6-5. Factor or multiplier for each class of flow path vegetation, based on Luce
and Black, 2001

Road Flow Path Vegetation | Vegetation Factor
0% 1

>10% 1

>25% 0.14

>50% 0.14

>75% 0.14

Indicators of gully initiation risk

Gullies below road drainage features are potentially major sediment contributors
from road systems. No tools currently estimate sediment production from gullies, or
even specify the probability of occurrence; however, several techniques are available as
indicators of relative risk of gully erosion. When only road line information is available,
there are several indicators based on the road location. These are discussed in the USFS
Roads Analysis methodology (Bisson et al., 1999). GRAIP incorporates additional

information about road drainage distances to predict gully formation at drain points.

USFS roads analysis indicators

USFS Roads Analysis (Bisson et al., 1999) uses stream channel proximity, slope
position and hillslope gradient as indicators of the possibility of gully formation. The
calculation used to obtain each indicator is explained below.

Stream channel proximity. The TauDEM distance to streams function was used

to evaluate the distance from each drain point to the stream. These distances were
classified into
a. Less than or equal to 100 meters

b. Greater than 100 and less than or equal to 200 meters
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c. Greater than 200 and less than or equal to 300 meters

d. Greater than 300 meters

Slope position. Slope position is the division into categories of a hillslope from
the ridge top, often the driest and most stable position, to the valley bottom, usually
wetter and subject to mass wasting, saturation overland flow, and increased groundwater
interception by roads. In this analysis, slope was divided into four classes based on the
position along the flow path from ridge top to stream. These classes were

a. Valley bottom — Distance to stream is between 0 and 25% of hillslope
flow path length.

b. Lower quarter — Distance to stream is between 25% and 50% of hillslope
flow path length.

c. Upper quarter — Distance to stream is 50% and 75% of hillslope flow path
length.

d. Ridge tops — Distance to stream is between 75% and 100% of hillslope
flow path length.

Slope position for the study area was evaluated by from the DEM using TauDEM
functions. The TauDEM grid network flow path length function calculates the longest
upslope flow path terminating at each grid cell. This is denoted as “plen”. The distance
to stream function calculates the distance from each grid cell to the stream network
defined by the stream raster grid. This is denoted as “dist”. The grid slope position was
calculated at each grid cell as dist divided by (dist+plen). This quantifies the fraction that
distance to the stream is of the complete hillslope flow path length. The classes a to d

above are then determined from this fraction.
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Hillslope gradient. Steeper hillslope gradients yield an increase in the bed

shear stress and stream power of water flowing out of road drains. Additionally, steem
hillslopes are commonly associated with an increase in the frequency of road failures.
Slope at each drain point was evaluated from the DEM using the GRAIP tool that
averaged down gradient a distance of 50 meters. Slope was then classified into 4 classes
with each class containing an approximately equal number of drain points.
GRALIP Indicator

GRALIP uses Erosion Sensitive Index (ESI) to asses the gully initiation risk at each
drain point. GRAIP ESI analysis is explained below.

Erosion sensitivity index. Montgomery (1994) and Istanbulluoglu et al. (2001a)

have related erosion potential to aS” where a is the contributing area, S is the slope and
« an exponent varying from 1 to 2. In the case of road drainage an erosion sensitivity
index (ESI) which uses the cumulative upslope road length draining to each drain point
and the slope at the drain point is defined. The cumulative length was used as a surrogate
measure for the quantity of road drainage and was obtained from the effective length
(ELength) calculated using GRAIP.

ESI = L.S* (6.5)
where L. is the total length of discharging road segments, S is the slope at the drain point
and « 1s taken as 2. GRAIP was used to calculate the slope at each drain point averaged
over a down gradient distance of 50 m. Effective road length at each drain point is the
contribution from each side of each road segment as different sides of the road segment

may drain to different drain points.
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Results

Sediment production

The sediment production values were calculated for the all the road segments in
the study area shown in Figure 6-1 using both the BOISED and GRAIP methods. Figure
6-4 illustrates the sediment production values from GRAIP and BOISED for each road
segment. GRAIP sediment production values were found to be approximately twice
those calculated by BOISED. To evaluate the differences in the sediment production
values, the parameters used for each of the models were examined. BOISED uses a
categorical slope factor (Table 6-3) whereas GRAIP uses slope directly in the evaluation
of sediment production. The standard road slope in BOISED is 6%. Figure 6-5 shows the
GRAIP slopes divided by 0.06 (6%) so that these factors are comparable. For slopes less
than 3% and between 5% and 6%, the BOISED slope factor is higher; otherwise, the
BOISED slope factor is lower. On average, the GRAIP slope factor is 1.65 times that of
the BOISED slope factor.

BOISED uses an age factor (AF) that was assigned based on flow path vegetation
according to Table 6-1. There are three discrete AF values in Table 6-1, which when
averaged for each side of the road result in a total of five possible average age factors in
BOISED. In GRAIP vegetation factor was assigned based on flow path vegetation
according to Table 6-5. There are two discrete vegetation factor values in Table 6-5,
which when averaged for each side of the road results in three possible average GRAIP
vegetation factors. Figure 6-6 plots the road segment average BOISED age factor versus

GRALIP vegetation factor. The six points that result comprise all the possible
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combinations from flow path vegetation on different sides of the road. The GRAIP

vegetation factors were generally estimated to be higher compared to BOISED age
factors.

Figure 6-7 illustrates the distribution of disturbed widths in the BOISED analysis.
GRALIP uses a constant disturbed width of 10 meters while the BOISED disturbed width
ranges from 4 meters to approximately 19 meters (Figure 6-7) depending on landtypes
(Appendix 6), with an average of 9.2.

Figure 6-8, compares the GRAIP and BOISED surface type mitigation factors
which are linearly related and differ by a factor of 4 for paved roads and 5 for gravel and
native roads. This does not play a role in differences between the models due to the
factor of 5 difference being factored in to the calculation of the base erosion rate
parameter a and the fraction of roads that are paved being very small.

Finally the distribution of Geologic Erosion Factor (GEF) for BOISED was
compared to the implicit uniform GRAIP GEF (Figure 6-9) that has a value of 1 because
geologic effects in GRAIP are controlled by the base erosion rate. The average GEF
from BOISED (1.05) is a little bigger than the GRAIP value of 1.

Table 6-6 lists the average values of multipliers calculated for the study area. The
product of the ratios between GRAIP and BOISED multipliers (from Table 6-6, 1.06/1.65
*0.8/0.9 * 9.2/10 * 1.05/1) gives a value of 0.55 representing the average difference in
the sediment production values calculated from each model. In Figure 6-4, some of the

difference is absorbed in the non-zero positive intercept.



Table 6-6. Comparison of multipliers for GRAIP and BOISED

Multiplier type (Average) GRAIP BOISED
Slope factor 1.65 1.06
Vegetation factor 0.9 0.8
Road width 10 9.2

GEF 1 1.05
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Figure 6-4. GRAIP vs BOISED road segment sediment production values.
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The calculated sediment production and delivery values (for both GRAIP and
BOISED) were then summarized for each six digit HUC sub-watershed (Figure 6-2). The
resulting aggregate sediment production and delivery values in each HUC region were
plotted to examine the relationship between GRAIP and BOISED. Figure 6-10 shows the
graph for HUC summarized by sediment production in each HUC. GRAIP has higher
estimates of sediment production values compared to BOISED as expected from the
earlier examination of the effects of multiplication factors for sediment estimation.

Because of the similarity of the formulation of the two models for sediment
production, some similarity is expected in sediment production values. There are

substantial differences in how the models work with respect to the delivery of sediment to
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the streams. BOISED assumes some delivery from each road segment based on the

landtype attributes while GRAIP uses delivery points identified in the field as connected
to streams. Although Figure 6-4 shows a relationship between sediment production for
each segment, Figure 6-11 shows nearly no relationship between sediment delivery from
the two models, with a distinct tendency for BOISED to under-predict delivery. This
difference is due to GRAIP having used stream connectedness information from the road
inventory that was not available to BOISED. In principle GRAIP should give a better
estimate of sediment delivery values. When aggregated over a six digit HUC sub-
watershed there is a reasonably strong relationship between the two models, with an R of
0.87 (Figure 6-12). The strong relationships in Figures 6-10 and 6-12 are primarily due
to the variation of the length of road in each sub-watershed. Comparing Figures 6-10 and
6-12, although the GRAIP calculated sediment production values in Figure 6-10 were
approximately twice as high as BOISED, the amount of sediment estimated to be
delivered to the streams in Figure 6-12 was approximately 6 times more than BOISED,
reflecting the underestimated delivery using landtype information.

Figure 6-13 compares the sediment delivery ratio (SDR), for GRAIP and
BOISED, calculated by dividing the sediment delivery for each HUC region with the
total sediment produced. The graph shows, similar to Figure 6-11, no relationship
between SDR for GRAIP and BOISED. The regression between SDR values for GRAIP
and BOISED has a p-value of 0.22, which is not significant.

Figures 6-14 and 6-15 compare the sediment production to the sediment delivery
for GRAIP and BOISED models, respectively. Approximately 5% of the sediment

production calculated using BOISED is delivered compared to 18% in GRAIP. The
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GRAIP calculations are believed to be more accurate because they use observed

information about the sediment delivery to streams from the USFS inventory.

Indicators of gully initiation risk

The USFS Roads Analysis indicators of gully formation (Slope Position, Stream
Channel Proximity and Slope or Hillslope) were compared with the GRAIP indicator of
gully formation (ESI Class).

Stream channel proximity. The terrain nearer to stream channels is generally

considered to be wetter due to higher upstream contributing area when compared to other
parts of the hillslope and hence more susceptible to gully formation. The USFS Roads
Analysis (Bisson et al., 1999) consequently uses stream channel proximity as an indicator
of the potential for gully formation. Table 6-7 lists the number of drain points and
observed gullies in each flow path distance class and Figure 6-15 shows the distribution
of gullies in each distance to stream channel class. We find that only 8.4% of drain
points less than 100 meters to the stream channel have gullies compared to 30.3% of
gullies observed between 100 and 200 meters. There is not a monotonic trend to the
percentage of drain points with gullies as a function of distance from the stream and the
average percentage of drain points with gullies is close to the percentage for all three of
the larger distance classes. The class of stream distances closest to the stream has the
lowest percentage of drain points with gullying, in contradiction to the hypothesis that the
potential for gullying is higher close to streams. One cause for the failure of this
hypothesis might be a different geomorphology for our study area compared to where this

hypothesis was developed. In some setting slopes are steep adjacent to streams, but in
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Table 6-7. Shows the classification of gullies with respect to distance from streams

Distance from Number of Number of Percentage of drain
Index | streams (meters) | drain points | gullies points with gullies
0 <100 143 12 8.39
1 100 - 200 33 10 30.30
2 200 - 300 27 5 18.52
3 300 < 60 12 20
Total 263 39 14.83
Stream Proximity
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Figure 6-16. Distribution of gullies and distance from stream channels.

our study area the slopes were generally less steep resulting in less gully formation
adjacent to streams. Based on these findings we conclude that for this data the distance
from the stream appears to be uninformative for predicting gullies.

Slope position. Figure 6-16 illustrates the slope position grid evaluated from the
TauDEM flow distance to streams and longest upslope flow path grids. The TauDEM
derived stream network, road segments and drain points classified as to whether gullies

were or were not observed are also shown.
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Table 6-8 gives drain points within each slope position class. According to

the Roads Analysis (Bisson et al., 1999), lower slope position is an indicator of gully
formation potential because it is associated with larger contributing area. We found that
the percent of drain points with gullies in the slope position class (Figure 6-17) 50% to
75% was approximately 27%. 12% of the drain points nearer to the ridge top (slope were
gullied while only 4.8% of drain points close to streams were gullied. This is in contrast
to the findings of Bisson et al (1999) for the Bluff Creek watershed in California. There,
slope position was divided into three classes, 20% for the upper slope positins and 40%
for mid and lower slope positions. Within the uppers slope position class 23 % of the
area was steeper than 50 % slope. Within the middle and lower slope position classes
about 35 % of the area was steeper than 50 % slope. The Bluff creek watershed had road
failures 30 times higher in the lower slope position class compared to the upper position.
From the fact that we do not find a monotonic relationship between slope position class
and percentage of drain points with gullies and from the fact that our data displays a
different relationship in comparison to Bisson et al.'s work we conclude that the
classification of the slope position does not appear to provide information on the potential
for gully formation. As for stream proximity, the differences may be due to differences
in regional geomorphology. In areas with high uplift rates (e.g. coastal areas) the "inner
gorge" with steep slopes near the streams may dominate gully formation, whereas in
areas with glacial pasts or very old mountains with wider flatter valley bottoms the

relationship with slope position is likely to be different.



Table 6-8. Shows the classification of gullies inside each slope position class
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Slope Position | Number of Number of Percentage of drain
Index | Class Drain Points Gullies points with gullies
0 < 25% 83 4 4.82
1 25-50% 53 5 9.43
2 50-75% 102 27 26.47
3 75 —100% 25 3 12

Total 263 39 14.83
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Figure 6-17. Grid of slope position classes.
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Figure 6-18. Distribution of gullies in each slope position class.

Slope at each drain point. Slope at each drain point was determined by

intersecting the drain point with the slope grid created from the DEM of the subset study
area shown in Figure 6-3, averaging over a 50 m down gradient distance. Figure 6-18
illustrates the slope classes that were derived so that each class contained approximately
the same number of drain points. The TauDEM derived stream network, road segments
and drain points classified as to whether gullies were or were not observed are also
shown. Table 6-9 shows the slope classes with number of drain points in each class and
the number of drain points having observed gullies in that class. Almost 29 % of drain
points with slope of more than 28.8 degrees have observed gullies. But the threshold used
for this indicator is a decisive factor in grouping the gullies. From Figure 6-19 we find
that more than 95% of the drain points with observed gullies have slope more than 8.5

degrees. But only 30% of the gullies have more than 28 degrees slope and almost 60% of
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Figure 6-19. Part of the road network with gullies mapped. The raster grid shows the slope
classification.

Table 6-9. Shows the classification of gullies inside each slope class

Number of Number of Percentage of drain
Index [ Slope Class (Degrees) | Drain Points | Gullies points with gullies
1 Slope <= 8.55 82 2 24
2 8.55< Slope <=17.2 64 10 15.6
3 17.2 <Slope <=28.8 62 11 17.7
4 Slope >28.8 55 16 29.1
Total 263 39 14.83
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them have lower slope. For slopes less than 8.5 degrees there is 2% chance of having

a gully and for slopes greater than 29 degrees there is a 29% chance of gullies. These two
classes clearly discriminates the gully initiation risk. But for the intermediate classes (2
and 3) chances of gullying are little above the mean percentage of gullies. Because of the
bin selection which holds approximately equal number of drain points roughly 50% of
the drain points fall into these two intermediate classes where the discrimination of gully

formation potential is limited.

Erosion sensitivity index. Calculation of GRAIP ESI used knowledge of effective
length, L, of the road draining to each drain point from the USFS road survey. This is
additional information over slope only, and requires field survey information. ESI was
evaluated as LS. The o was taken as 2 (Montgomery, 1994; Istanbulluoglu et al., 2001a).
Table 6-10 shows the number of drain points and observed gullies for each class. Figure
6-20 shows the distribution of gullies in each ESI class. The drain point slope — length
graph in Figure 6-21 shows the ESI lines that discriminate the slope and effective length
space into the four classes with varying percentage of drain points with gullies given in
Table 6-10. Table 6-10 and Figure 6-21 indicate that 85% of the observed gullies are
found at drain points with ESI values greater than 8. The middle ESI class (Index 3 in
Table 6-10) shows that after a threshold ESI value (8 in this case) the chances of gullying
are high. Here the first two classes containing approximately 50% of drain points with
ESI values less than 8, hold 5 % of the drain points having gullies and the other two
classes with ESI values more than 8 have 28% chance of gullying. This categorization
into ESI classes has provided a good discrimination of the potential for gully formation at

drain points.
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Table 6-10. Classification of gullies inside each ESI class
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ESI Value | Number of drain Percentage of drain
Index | Class points Number of gullies | points with gullies
1 <1.25 81 4 4.94
2 1.25-8 64 3 4.69
3 8.01-25 |63 18 28.57
4 > 25 55 14 25.45

Total 263 39 14.83
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Conclusion

This chapter compared the USFS Roads Analysis methods to analyze the impact
of forest roads on watersheds, with the GRAIP model. The comparison started with the
calculation of sediment production values using the BOISED model used by the USFS,
and the GRAIP road surface erosion analysis. Sediment production values from GRAIP
were found to be twice as high as BOISED both at the road segment scale and HUC
scale. The sediment delivery values for GRAIP were approximately 6 times higher than
BOISED. Because GRAIP calculates sediment delivery from the observed road-stream
connectivity information, we believe the GRAIP values to be a better estimate of stream
sediment inputs. These results indicate that while BOISED may provide a rough estimate
of sediment delivery at the sub-watershed scale (six-digit HUC); segment scale estimates
require information about the drainage and delivery patterns. Segment scale information
can be valuable in targeting treatments to roads to meet regulatory requirements.
Furthermore, corrections for basin-scale delivery can be provided from a field based
inventory of delivery to improve estimates from a model like BOISED.

The next comparison dealt with the indicators used in the USFS Roads Analysis
and GRAIP to analyze the risk of gully initiation at drain points. The stream channel
proximity and slope position indicators in the USFS Roads Analysis could be used only
in the context of a regional calibration to provide expectations about the pattern of gully
occurrence with location. The slope (hillslope) class indicator in the USFS Roads
Analysis showed clearer influence in predicting gullies compared to former two. In the

case of the GRAIP ESI gully initiation risk indicator, above a particular threshold the
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chances of gullying were consistently high, while below that threshold, they were
consistently low. For roads with intermediate sideslopes (between 8.5 and 28 degrees),
representing about ' of the drainpoints, the ESI model is more informative than slope
alone.

Overall, this chapter has compared erosion, sediment delivery, and gullying
indicators calculated from detailed attributes of road drainage, with more generalized
calculations. The results demonstrates that, as suggested by Wold and Dub¢ (1998), and
Luce and Wemple (2001), a detailed road inventory can provide the basis for a more

informative analysis of road impacts on forest watersheds.
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CHAPTER 7

CONCLUSION

This thesis presents a new way to integrate different terrain analysis models and
GIS analysis tools and techniques to evaluate the impact of forest roads on watersheds.
The model was implemented as a set of GIS tools and functions and as GIS procedures
using terrain analysis (TauDEM), and slope stability analysis (SINMAP). Several GIS
techniques were also developed to process the data for the analysis.

This thesis also presents a new relational database design, based on the USFS
road inventory, to formally organize and structure the data that represents the interaction
between roads, drain points, hillslopes and stream networks to enable and facilitate road
impact assessments. A database preprocessor tool was developed to validate and import
the USFS road inventory into the new relational database.

The procedures were programmed using a combination of C++ and Visual Basic
6.0 as library functions compiled into a Microsoft Component Object Model (COM)
Dynamic link library. The GIS toolbar was implemented as an ArcGIS ArcMap toolbar
that uses ArcObjects software components inside Visual Basic 6.0 to access spatial
analysis and other ArcGIS functionalities used in the model. The software accesses data
in the ESRI grid format using the RasterlO application programmer’s interface. The
database preprocessor tool was developed as a standalone tool using Visual Basic and
C++. Both the GIS toolbar and the database preprocessor tool communicate with the
Microsoft Access Database using the MS ActiveX Data Object and SQL. The database

preprocessor tool and the GIS model uses the Shapefile C Library
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(http://shapelib.maptools.org/), which provides the ability to write simple C programs

for reading, writing and updating shapefiles, and the associated attribute file (.dbf).

The complete model developed during the course of this work is called the
Geomorphologic Road Analysis and Inventory Package (GRAIP) and includes the
following components

1. Database schema,

2. Database preprocessor,

3. GIS methods for properly locating road stream crossings on streams so that a
stream network segmented at these points can be delineated,

4. GIS procedures to develop a slope stability index map using SINMAP,

5. Road surface erosion and stream sediment delivery module,

6. Mass wasting potential module for the impacts of road drainage on both landslide
and erosion risk,

7. Stream blocking analysis module,

8. Stream habitat contiguity module.

The GRAIP tool was used to quantify the impacts of forest roads in a case study
within the South Fork of the Payette River within the Boise National Forest. The
sediment production from forest roads, accumulated sediment load at each drain point,
and sediment delivery to each stream segment was calculated and recorded in the
database. Maps for the part of the study area were presented to illustrate how the results
are useful for forest road analysis. These maps can be used by forest managers and

decision makers to identify road segments and drain points with high erosion and high
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potential for delivery of sediment to streams, for use in the planning of future
maintenance or decommissioning priorities.

The GRAIP terrain stability analysis calculated the SINMAP stability index
values at each drain point. The GRAIP modified SINMAP approach considered both
terrain and road effects on the slope stability and produced a map of stability index values
accounting for road drainage effects. This map shows the effect of additional discharge
on slope stability downslope from drain points and is useful for analysis of the effect of
road drainage on terrain stability.

The gully initiation risk for each drain point was analyzed by calculating erosion
sensitivity index (ESI) values. A graph was developed to group the display of drain
points into classes with low, medium and high risk for gullying. The ESI lines bounding
classes were specified so as to obtain classes holding an approximately equal number of
drain points. Observed gullies were also displayed on the graph to better understand the
relationship between ESI and gully formation at each drain point. More than 80 percent
of the observed gullies were found to be located in medium and high ESI regions. The
ESI can be used to determine a threshold value above which the chances of gullying are
high.

A stream blocking susceptibility analysis was carried out for each drain point
based on attributes of drain points recorded in the road inventory. Streams can be
blocked by organic debris or sediments and this analysis helps to identify the drain points
which are at risk.

The final module in GRAIP is the habitat segmentation module. Road-stream

crossings may be barriers to fish passage. This module filtered GPS surveyed stream
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crossings in an effort to properly locate them on streams. A stream network with

streams segmented at stream crossings was then derived from the DEM. The stream
crossings were then analyzed for fish passage barrier status based on culvert and other
stream crossing attributes from the road inventory. Using this information stream habitat
clusters within the stream network were identified. The map of the habitat clusters
identifies the stream blockages and contiguous fish habitats and is a tool for prioritization
of stream crossing maintenance and barrier correction.

A model comparison study was performed to compare the existing USFS Roads
analysis methods and GRAIP. For sediment production, the BOISED model was
compared with GRAIP. This comparison found that GRAIP estimates were twice as high
as the sediment production values from the BOISED model. This difference was
explained in terms of the contribution of the various multipliers in each model to the
overall difference. The amount of sediment estimated, by GRAIP, to be delivered to the
streams was approximately 6 times higher than BOISED. This is believed to be a more
reliable estimate because it is based on direct survey of the drain points connected to
streams.

Existing geomorphologic indicators for the risk of gully initiation were also
compared to the GRAIP ESI. We found that the slope position and stream channel
proximity indicators in the USFS Roads Analysis do not predict the potential for gully
formation very well. Both the terrain slope, which is a USFS gully initiation indicator,
and GRAIP ESI showed good relationships with observed gullying. The fraction of drain
points with observed gullies increased as the slope got steeper or the ESI increased. In

the case of the GRAIP ESI indicator, more than 80 percent of the drain points where
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gullies were observed had ESI greater than threshold value of 8. ESI, that makes use

of information on the length of road draining to each drain point, was found to be a better
discriminator of the potential for gully formation than slope alone.

Overall this study has shown that a detailed road inventory containing information
about the road and drain points helps in predicting the impacts of forest roads on the
watershed. The inventory proposed by Luce and Black (2002) comprises a detailed GPS
survey of the road system. The GRAIP model is based on this surveyed inventory
information. The model comparison showed that with more information on road and
drain point attributes, the analyses can better predict sediment production, sediment
delivery, terrain instability due to road drainage, gully initiation risks and habitat
segmentation. The GRAIP relational database also improves data integrity and
consistency resulting in a better quality dataset for more accurate GIS road analysis.

One of the problems that is faced in performing a GRAIP analysis is the correct
positioning of drain point and stream crossing on DEM delineated streams, due to
imprecision in both the GPS positions and the delineated stream network. Additional
information like the presence of streams and estimated distance to the stream in the road
inventory would be helpful to locate the stream crossings more precisely. It is
recommended to that field crews refer to the stream network delineated from the digital
elevation model using TauDEM while conducting the GPS survey to facilitate the
collection of this information. The surveyor should, at the time of mapping a stream
crossing, identify stream segment that is crossed and provide a description of the position
of the stream relative the road segment. This information would be helpful for verifying

the consistency of the TauDEM stream network with observed streams while locating
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road-stream crossings properly. Images or photos of drain points which have resulted

in the formation of gullies and landslides along the road would be helpful for further
evaluation of model predictions where it is useful to be able to visually check the

appearance of the site.
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APPENDIX 1

USFS Road Inventory Tables Data Dictionary




Roads Shapefile Attribute Table

137

Field Name Description
IDRAINNUM Main road drainage feature
2DRAINNUM Secondary road drainage feature
SURF TYPE Road surface type
SURF COV Road surface cover
SURF COND Road surface condition
RD EDGE 1 Cut slope height or road edge feature
RD EDGE 2 Cut slope height 2 or road edge feature
EDGE VEG 1 Road side vegetation density
EDGE VEG 2 Secondary road side vegetation density
EDGE CND 1 Primary cut or fill slope condition
EDGE CND 2 Secondary cut or fill slope condition
FLOW_ PATHI Location of flowing water
FLOW_ PATH2 Location of flowing water
FLWPTH VGl Vegetation on flow path 1
FLWPTH VG2 Vegetation on flow path 2
FLWPTHCNDI Condition of flow path 1
FLWPTHCND2 Condition of flow path 2
FILL CHAN Distance. Fill slope toe to channel edge in feet
Date Collection date
Vehicle Vehicle number used for survey

Ditch Relief Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature number
Size Pipe diameter in inches
Pipe Len. (ft.) Pipe length
Type Pipe material
Condit Percent sediment occlusion
Slope Shap Shape of the slope. Eg: concave
Dischrg to Destination of discharge
Stream Con Stream connection
Fill Eros Is fill slope eroded below pipe
Flow Diver Flow diversion present or not
Obstruct Debris in flow path of drain
Flow diffuser Flow diffuser type
Date Collection date
Vehicle Collection vehicle identifier
Comment Additional comments




Stream Crossing Drain Point Shapefile Attribute Table
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Field Name Description
DRAINNUM Main road drainage feature identifier
Type Culvert type
R Pipe Dia. Round pipe diameter
Oval Pipe Oval pipe dimension
Pipe Len. Pipe length
Chan. wdth Channel width
Pipe Num Number of pipe present
Fill Depth Units of feet
Condit Culvert condition
Chan Angl Angle between pipe and channel
Block Typ Evidence of blockage
Outlet drp Measured below pipe in feet and tenths
Pl depth Depth below outfall in feet and tenths
Pipe grade Measured in %
Substrate Crossing substrate
Debris Flw Debris flow present or not
Fill Erosn Flow present erosion present or not
Diversion Diversion potential
Date Collection date
Vehicle Collection vehicle identifier
Comment Additional comments

Lead-off Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape
Dischrg to Destination of discharge
Stream Con Stream connection present or not
Condit Condition
Obstruct Debris in flow path of drain
Date Collection date
Vehicle Collection vehicle identifier

Comment




Water Bar Drain Point Shapefile Attribute Table
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Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape
Dischrg to Destination of discharge
Stream Con Stream Connection present or not
Obstruct Debris in flow path of drain
Fill Eros Fill erosion present or not
Type Drain point material
Condit Condition
Date Collection date
Vehicle Collection vehicle identifier
Comment

Broad Based Dip Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Shape of the slope
Dischrg to Destination of discharge
Stream Con Stream connection
Obstruct Debris in flow path of drain
Fill Eros Fill erosion present or not
Type
Condit Condition of the drain point
Material
Date Collection date
Vehicle Collection vehicle identifier
Comment

Non-Engineered Drain Point Shapefile Attribute Table

Field Name Description

DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape

Dischrg to Destination of discharge

Stream Con Stream connection present or not
Obstruct Debris in flow path of drain

Fill Eros Fill erosion present or not

Condit Condition

Date Collection date
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Vehicle

Collection vehicle identifier

Comment

Sump Drain Point Shapefile Attribute Table

Field Name Description

DRAINNUM Main road drainage feature identifier
Condit Condition

Date Collection date

Vehicle Collection vehicle identifier
Comment

Diffuse Drain Point Shapefile Attribute Table

Field Name Description

DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape

Dischrg To Destination of discharge

Stream Con Stream connection present or not
Obstruct Debris in flow path of drain

Fill eros Fill erosion present or not

Date Collection date

Vehicle Collection Vehicle identifier

Comment
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APPENDIX 2

GRAIP Database Tables




Master tables

DrainPoints Table
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Field Name Description

GRAIPDID Unique Drain Point identifier

DrainTypelD Unique Drain Point type identifier

CDate Survey date

CTime Survey time

VehiclelD Survey vehicle Identifier

DrainlD Drain ID from Road inventory Drain points file

StreamConnectID Attribute representing stream connection present or not

Comments Description or comments about the Drain Point feature

SedProd Accumulated Road Sediment load to each drain point
(kg/yr)

ELength Effective length of the road draining to each drain point
(m)

UnitSed Drain point unit sediment load (kg/m/yr)

SedDel Sediment load delivered to streams

SI SINMAP Stability Index values at each drain point

Slope Slope at each drain point

ESI Erosion Sensitivity Index (m) values at each drain point

PipeDiaToChanWidthScore

Hazard Score calculated from Ratio of Culvert pipe
diameter to channel width

SkewAngleScore Hazard Score calculated from Channel Skew angle

SBI Stream blocking index indicating culvert plugging
susceptibility

Barrier Flag representing the drain point is a fish passage barrier
or not

RoadLines Table
Field Name Description

GRAIPRID Unique Road line segment Identifier

CDate Survey date

CTime Survey time

VehiclelD Survey vehicle identifier

RoadNetworkID Identifier for a road network. Base erosion rate depends on
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road network ID

RoadTypelD Identifier for type of the road (eg: system road, trail)

GRAIPDIDI Identifier of drain point that drains side one of the road

GRAIPDID2 Identifier of drain point that drains side two of the road

SurfaceTypelD Identifier representing road surface type.

SurfaceConditionID Identifier representing road surface condition

SurfaceCoverID Identifier representing the road surface cover

RoadEdgelID Identifier for road side one edge information

RoadEdge2ID Identifier for road side two edge information

EdgeVegetation1ID Identifier for road side one edge vegetation

EdgeVegetation2ID Identifier for road side two edge vegetation

FlowPath11D Identifier for road side one flow path information

FlowPath2ID Identifier for road side two flow path information

FlowPathVeglID Identifier for road side one flow path vegetation

FlowPathVeg2ID Identifier for road side two flow path vegetation

FlowPathCond11D Identifier for road side one flow path condition

FlowPathCond2ID Identifier for road side two flow path condition

FillChannellD Identifier giving road fill channel information

Comments Additional Comments about the road segment

StreamConnect11D Identifier for road side one stream connectivity status

StreanConnect21D Identifier for road side two stream connectivity status

Length Length of the road segment (m)

SedProdl Sediment production from side one of the road (kg/yr)

SedProd2 Sediment production from side two of the road (kg/yr)

UnitSed Unit sediment production from both sides of the road
segment (kg/m/yr)

TotSedProd Total sediment production from both sides of the road
(kg/yr)

TotSedDel Total sediment delivered to streams (kg/yr)

UnitTotSedDel Total unit sediment delivered to streams (kg/m/yr)

BroadBaseDipAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

BroadBaseDipTypelD Identifier representing Broad Base Dip type

SlopeShapelD Identifier for drain point discharge slope shape

DischargelD Identifier for drain point discharge feature (e.g. gully,
forest floor)

Obstruction]D Identifier for the presence of an obstruction
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FillErosionID

Identifier for presence of fill erosion

BroadBaseDipConditionID

Identifier for broad base dip drain point condition

MateriallD Identifier for material found in the drain point
DiffuseDrainAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)
Obstruction]D Identifier for the presence of an obstruction
FillErosionID Identifier for presence of fill erosion
DitchReliefAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SizelD Identifier for the size of the drain point
PipeLength Length of the culvert pipe used
DitchReliefTypelD Identifier for ditch relief type
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)
FillErosionID Identifier for presence of fill erosion
ObstructionID Identifier for the presence of an obstruction
FlowDiversionlD Identifier for the presence of flow diversion
FlowDiffuserID Identifier for flow diffuser type
LeadOffAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in

DrainPoints Table

SlopeShapelD

Identifier for drain point discharge slope shape
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DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)

LeadOffConditionID Identifier for condition of lead off drain point

ObstructionID Identifier for the presence of an obstruction

NonEngAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

NonEngConditionID Identifier for condition of Non-Engineered drain point

SlopeShapelD Identifier for drain point discharge slope shape

DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)

Obstruction]D Identifier for the presence of an obstruction

FillErosionID Identifier for presence of fill erosion

StrXingAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

StrXingTypelD Identifier for stream crossing type

PipeDimID Identifier for culvert pipe dimension

PipeLength Culvert pipe length (feet)

ChannelWidth Channel width (feet)

PipeNumberID Identifier for number of pipes used

FillDepth Fill depth (feet)

StrXingConditionID Identifier for condition of stream crossing drain point

FillErosionID Identifier for presence of fill erosion

ChannelAngleID Identifier for angle between stream and stream crossing

BlockTypelD Identifier for the presence and type of stream crossing
blockage

OutletDrop Outlet channel drop (feet)

PoolDepth Channel pool depth (feet)

PipeGradient Stream crossing pipe gradient in percentage

SubstratelD Identifier for substrate material

DebrisFlowID Identifier for the presence of a debris flow

DiversionlD Identifier for the presence and direction of channel
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| diversion

SumpAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SumpConditionID Identifier for condition of sump drain point
WaterBarAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
WaterBarTypelD Identifier for water bar type
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully, forest
floor)
Obstruction]D Identifier for presence of obstruction
FillErosionID Identifier for presence of fill erosion
WaterBarConditionID | Identifier for condition of water bar crossing drain point




147
Preferred value tables

BlockTypeDefinitions

BlockTypelD | BlockType Description

1 No Stream crossing not blocked (default)

2 Sediment Plume Stream crossing blocked by sediment plume

3 Scoured road Stream crossing blocked due to scoured road

4 Washed out road | Stream crossing blocked due to washed out road
5 Organic debris pile | Stream crossing blocked by organic debris pile

BroadBaseDipCondDefinitions

BroadBaseDipConditionID | Condition Description
1 No Problem Default

2 Puddles on road

3 Wetland in ditch

4 Saturated fill

BroadBaseDipTypeDefinitions

BroadBaseDipTypelD | BroadBaseDipTypeName | Description
1 Grade Reversal Default

2 Flat Ditch

3 Constructed

ChannelAngleDefinitions

ChannelAngleID | ChannelAngle | Description

1 <25 degrees The flow changes direction by less than 25 degrees
when entering stream crossing (Default)

2 <45 degrees The flow changes direction by less than 45 degrees
when entering stream crossing

3 45-75 degrees | The flow changes direction by between than 45 and
75 degrees when entering stream crossing

DebrisFlowDefinitions

DebrisFlowID | DebrisFlow | Description

1 No Default

2 Yes




DischargeToDefinitions
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DischargeTolD | DischargeTo | Description

1 Forest Floor | Default

2 Gully

3 Ditch

4 Landslide

5 Wetland

6 Stream

DitchReliefCondDefinitions

DitchReliefConditionID | Condition Description

1 0 Ditch relief drain in good condition
2 1-20% Ditch relief drain 1-20% blocked

3 20-80% Ditch relief drain 20-80% blocked

4 80-100% Ditch relief drain 80-100% blocked
5 Partially Crushed Ditch relief drain partially crushed

6 Totally Crushed Ditch relief drain totally crushed

7 Rusted Significantly | Ditch relief drain significantly rusted
8 Flows around pipe | Ditch relief drain flows around the pipe

DitchReliefTypeDefinitions

DitchReliefTypelD | DitchReliefTypeName | Description
1 CMP (Steel) Default
2 CON (Concrete)

3 ALM (Aluminum)

4 ABS (Plastic)

5 WDN (LOG)
DiversionDefinitions

DiversionID | Diversion | Description

1 None Default

2 1 Direction

3 2 Direction
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DrainTypeDefinitions

DrainTypelD | DrainTypeName | TableName Description

1 Broad base dip | BroadBaseDipAtt | Attribute table name for Broad
Base Dip type drain point

2 Diffuse drain DiffuseDrainAtt | Attribute table name for Diffused
type drain point

3 Ditch relief DitchReliefAtt Attribute table name for Ditch
Relief type drain point

4 Lead off LeadOffAtt Attribute table name for Lead Off
type drain point

5 Non-engineered | NonEngAtt Attribute table name for Non-
Engineered type drain point

6 Stream Crossing | StrXingAtt Attribute table name for Stream
Crossings type drain point

7 Sump SumpAtt Attribute table name for Sump
type drain point

8 Water bar WaterBarAtt Attribute table name for Waterbar
type drain point

FillErosionDefinitions

FillErosionID | FillErosion | Description

1 No Default

2 Yes

FlowDiffuserDefinitions

FlowDiffuserID | FlowDiffuser Description

1 None Default

2 Half pipe fabric

3 Fabric hose

4 Rip rap

FlowDiversionDefinitions

FlowDiversionID | FlowDiversion | Description

0 Unknown

1 No

2 Yes




LeadOffCondDefinitions

LeadOffConditionID | Condition Description
1 No problem Default
2 Gullied

3 Not functional

4 Excess deposition
MaterialDefinitions

MaterialID | MaterialName | Description

1 Crushed

2 Native soil Default

3 Vegetated

4 Paved

5 Cinder

NonEngCondDefinitions

NonEngConditionID | Condition Description
1 Blocked Default

2 Diverted wheel track

3 Broken berm

4 Gully

5 Crosses road

6 Out sloped

ObstructionDefinitions

ObstructionID | Obstruction | Description

1 None Drain point not obstructed

2 Moderate Drain point has moderate obstruction (Default)
3 Abundant | Drain point has considerable obstruction
PipeDimDefinitions

PipeDimID | Dimension | Description

0 N/A Default

1 12 Round 12 inch pipe

2 15 Round 15 inch pipe
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3 18 Round 18 inch pipe

4 24 Round 24 inch pipe

5 36 Round 36 inch pipe

6 48 Round 48 inch pipe

7 60 Round 60 inch pipe

8 >60 Pipe greater than 60 inches diameter
9 13X17 Oval pipe 13 inches x 17 inches
10 15X21 Oval pipe 15 inches x 21 inches
11 20X28 Oval pipe 20 inches x 28 inches
12 24X35 Oval pipe 24 inches x 35 inches
13 29X42 Oval pipe 29 inches x 42 inches
14 33X49 Oval pipe 33 inches x 49 inches
15 38X57 Oval pipe 38 inches x 57 inches

PipeNumberDefinitions

PipeNumberID | PipeNumber | Description

0 N/A Default

1 1

2 2

3 3

4 >3

SizeDefinitions

SizelD | DSize | Description

1 <12" | Pipe size less than 12 inches
2 12" 12 inch pipe

3 15" 15 inch pipe

4 18" 18 inch pipe (Default)

5 24" 24 inch pipe

6 >24" | Pipe size greater than 24 inches

SlopeShapeDefinitions

SlopeShapelD | SlopeShape | Description
1 Concave

2 Planar

3 Convex
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StreamConnectDefinitions
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StreamConnectID | StreamConnection | Description

0 Unknown

1 No Drain point discharge does not enter stream
directly. (Default)

2 Yes Drain point discharge enters stream directly

StrXingCondDefinitions

StrXingConditionID | Condition Description
1 Open and Sound Default
2 Partially blocked

3 Totally blocked

4 Partially crushed

5 Totally crushed

6 Rusted significantly

7 Flows around pipe

8 Scoured under bridge
StrXingTypeDefinitions

StrXingTypelD | StrXingTypeName Description
1 Steel culvert round Default

2 Steel culvert oval

3 Steel arch bottomless

4 Plastic culvert

5 Baffled culvert

6 Concrete culvert

7 Log culvert

8 Concrete ford

9 Natural ford

10 Aluminum culvert

11 Bridge

SubstrateDefinitions

Substrate]D | Substrate Description

1 Culvert Material | Default

2 Sand

3 Gravel




4 Boulders

5 Bedrock

6 Baffled

7 Concrete

SumpCondDefinitions

SumpConditionID | Condition Description
1 No problem Default

2 Fill saturation

3 Puddles on road

WaterBarCondDefinitions

WaterBarConditionID | Condition Description
1 No problem Default
2 Damaged

3 Too small

4 Drains inboard ditch

5 Wheel track damage
WaterBarTypeDefinitions

WaterBarTypelD | WaterBarTypeName | Description
1 Road material Default

2 Fabricated material
EdgeConditionDefinitions

EdgeConditionID | EdgeCondition Description
1 No problem Default

2 Badly rilled

3 Badly ravelling

4 Badly slumping

5 Bedrock

EdgeVegetationDefinitions

153

EdgeVegetationID | EdgeVegetation | Description

1 Default Road side vegetation density is unknown or not
specified

2 >75% Road side vegetation density is greater than 75%
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3 >50% Road side vegetation density is greater than 50%
4 >25% Road side vegetation density is greater than 25%
5 >10% Road side vegetation density is greater than 10%
6 0% Road side vegetation density is less than 10%

FillChannelDefinitions

FillChannellD | FillChannel Description

1 0,[1] Fill slope ends right at channel

2 1-20,[20] Distance from fill slope toe to channel is between 1 and
20 feet

3 21-50,[50] Distance from fill slope toe to channel is between 21
and 50 feet

4 Above Distance from fill slope toe to channel is greater than

50,[100] 50 feet (Default)

FlowPathCondDefinitions

FlowPathCondID | FlowPathCond | Description

1 No problem Default

2 Gullied

3 Buried

4 Rutted

5 Blocked

6 Stream course

7 Woody veg (%)

FlowPathDefinitions

FlowPathID | FlowPath Description

1 Ditch Default

2 Wheel tracks

3 Base of cut

4 Berm

5 Diffuse

FlowPathVegDefinitions

FlowPathVegID

FlowPathVeg | Description

Multiplier

1

110% Unknown or unspecified road side flow

1




155

path vegetation density (Default)

2 >75% Road side flow path vegetated more than | 0.14
75%

3 >50% Road side flow path vegetated 50% to 0.14
75%

4 >25% Road side flow path vegetated 25% to 0.14
50%

5 >10% Road side flow path vegetated 10% to 1
25%

6 >0% Road side flow path vegetated 0 to 10% 1

7 0% No road side flow path vegetation 1

RoadEdgeDefinitions

RoadEdgelID | RoadEdge | Description

1 Fill Road side feature is fill

2 0' no ditch | Road side level with terrain, no ditch

3 0-6' Road side cut between 0 and 6 ft high (Default)

4 6-18' Road side cut 6 to 18 ft high

5 >18',0% | Road side cut higher than 18 ft

RoadNetworkDefinitions

RoadNetworkID | RoadNetwork | Description BaseRate

1 Default Default Base rate from Luce and Black, 79

1999

2 Custom Custom base rate for a specific study area | 79

RoadTypeDefinitions

RoadTypelD | RoadType Description

1 Default Default

2 System road

3 High clearance road

SurfaceConditionDefinitions

SurfaceConditionID

SurfaceCondition | Description

1

Good




2 Rilled/eroded
3 Washboard

4 Rutted

5 Rocky

SurfaceCoverDefinitions
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SurfaceCoverID | SurfaceCover | Description

| >75% Road surface is vegetated more than 75% (Default)
2 >50% Road surface is vegetated between 50 and 75%

3 >25% Road surface is vegetated between 25 and 50%

4 >10% Road surface is vegetated between 10 and 25%

5 0% Road surface is vegetated between 0 and 10%

SurfaceTypeDefinitions

SurfaceTypelD | SurfaceType Description | Multiplier
1 Default Default 1

2 Crushed rock 1

3 Native 5

4 Paved 0.2

5 Herbaceous Veg 1

6 Brush 1

7 Trees > 4 in Dia 1

8 Cinder 1
VehicleDefinitions

VehicleID | Vehicle Description

1 Survey Truck

Utility tables

FieldMatches

ID | AttTableID | DBField DBFField
1 1 Cdate Date

2 1 Ctime Time

3 1 VehiclelD Vehicle

4 1 DrainID DRAIN ID




5 1 StreamConnectID STREAM CON
6 1 Comments COMMENT

7 1 BroadBaseDipTypelD TYPE

8 1 SlopeShapelD SLOPE SHAP
9 1 DischargeTolD DISCHRG T
10 |1 ObstructionID OBSTRUCT

11 |1 FillErosionID FILL EROS

12 |1 BroadBaseDipConditionID | CONDIT

13 |1 MateriallD MATERIAL

14 |2 Cdate Date

15 |2 Ctime Time

16 |2 VehicleID Vehicle

17 |2 DrainID DRAIN ID

18 |2 StreamConnectID STREAM CON
19 |2 Comments COMMENT

20 |2 SlopeShapelD SLOPE SHAP
21 |2 DischargeTolD DISCHRG TO
22 |2 ObstructionID OBSTRUCT

23 |2 FillErosionID FILL EROS

32 |3 Cdate Date

33 |3 Ctime Time

34 |3 VehicleID Vehicle

35 |3 DrainID DRAIN ID

36 |3 StreamConnectID STREAM_ CON
37 |3 Comments COMMENT

38 |3 SizelD SIZE

39 |3 PipeLength PIPE LEN

40 |3 DitchReliefTypelD TYPE

41 |3 DitchReliefConditionID CONDIT

42 |3 SlopeShapelD SLOPE SHAP
43 |3 DischargeTolD DISCHRG TO
44 |3 FillErosionID FILL EROS

45 |3 ObstructionID OBSTRUCT

46 |3 FlowDiversionID FLOW DIVER
47 |3 FlowDiffuserID FLOW_ DIFFU
49 | 4 Cdate Date

50 |4 Ctime Time

51 | 4 VehicleID Vehicle

52 |4 DrainID DRAIN ID

53 |4 StreamConnectID STREAM CON
54 | 4 Comments COMMENT

55 4 SlopeShapelD SLOPE SHAP
56 | 4 DischargeTolD DISCHRG TO
57 |4 LeadOffConditionID CONDIT

157



58 | 4 ObstructionID OBSTRUCT
60 |5 Cdate Date

61 |5 Ctime Time

62 |5 VehiclelD Vehicle

63 |5 DrainlD DRAIN ID

64 |5 StreamConnectID STREAM CON
65 |5 Comments COMMENT
66 |5 NonEngConditionID CONDIT

67 |5 SlopeShapelD SLOPE SHAP
68 |5 DischargeTolD DISCHRG TO
69 |5 ObstructionID OBSTRUCT
70 |5 FillErosionID FILL EROS
71 |6 Cdate Date

72 | 6 Ctime Time

73 |6 VehiclelD Vehicle

74 |6 DrainlD DRAIN ID

75 |6 StreamConnectID

76 | 6 Comments COMMENT
77 |6 StrXingTypelD TYPE

78 | 6 PipeDimID R PIPE DIA
79 16 PipeDimID(Oval) OVAL PIPE
80 | 6 PipeLength PIPE LEN
81 | 6 FillDepth FILL DEPTH
82 |6 StrXingConditionID CONDIT

83 | 6 FillErosionID FILL EROSN
84 |6 ChannelAngleID CHAN ANGL
85 | 6 BlockTypelD BLOCK TYP
86 | 6 OutletDrop OUTLET DRP
87 | 6 PoolDepth PL DEPTH
88 |6 PipeGradient PIPE_ GRADE
89 | 6 SubstrateID SUBSTRATE
90 |6 DebrisFlowID DEBRIS FLW
91 |6 DiversionlD DIVERSION
93 |7 Cdate Date

94 |7 Ctime Time

95 |7 VehicleID Vehicle

9% |7 DrainlD DRAIN ID

97 |7 StreamConnectID STREAM CON
98 |7 Comments COMMENT
9 |7 SumpConditionID CONDIT

100 | 8 Cdate Date

101 | 8 Ctime Time

102 | 8 VehiclelD Vehicle

103 | 8 DrainID DRAIN ID
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104 | 8 StreamConnectID STREAM CON
105 | 8 Comments COMMENT
106 | 8 WaterBarTypelD TYPE
107 | 8 SlopeShapelD SLOPE SHAP
108 | 8 DischargeTolD DISCHRG TO
109 | 8 ObstructionID OBSTRUCT
110 | 8 FillErosionID FILL EROS
111 | 8 WaterBarConditionID CONDIT
112 | 6 PipeNumberID PIPE NUM
114 | 0 Cdate Date
11510 Ctime Time
116 | 0 VehiclelD Vehicle
11710 RoadTypelD ROAD TYPE
118 | 0 RSAMDID1 1 Drain ID
11910 RSAMDID2 2 Drain_ID
120 | 0 SurfaceTypelD SURF TYPE
121 10 SurfaceConditionID SURF COND
122 10 RoadEdgelID RD EDGE 1
123 |0 RoadEdge2ID RD EDGE 2
124 | 0 EdgeVegetationlID EDGE VEG 1
12510 EdgeVegetation2ID EDGE VEG 2
126 | 0 EdgeCondition11D EDG CND 1
127 1 0 EdgeCondition2ID EDG CND 2
128 | 0 FlowPath11D FLOW PATHI1
129 | 0 FlowPath2ID FLOW PATH2
130 | 0 FlowPathVeglID FLWPTH VGl
131 |0 FlowPathVeg2ID FLWPTH VG2
13210 FlowPathCond1ID FLWPTHCNDI1
13310 FlowPathCond2ID FLWPTHCND2
13410 FillChannellD FILL CHAN
135/ 0 HUC6Name HUC6NAME
136 | 0 Miles MILES
13710 Comments COMMENT
138 1 0 SurfaceCoverID SURF COV
13910 OrigSourceCode FID 1
DPErrorLog Table Structure

Field Name Description
Index Unique identifier (Auto number in MS Access)
GRAIPDID Identifier from DrainPoints table
DrainID Identifier from USFS road inventory

DrainType

Type of the drain point (Eg: Broad Base Dip)




ErrorMessage

Validation error message

ActionTaken

Action taken to correct error

RDErrorLog Table Structure

Field Name Description
Index Unique identifier (Auto number in MS Access)
GRAIPRID Identifier from RoadLines table
RoadID Identifier from USFS road inventory
RoadType Type of road line (Eg: System road)
ErrorMessage Validation error message
ActionTaken Action taken to correct error
MetaData
ID | IDFieldName DefinitionTable
1 | DrainTypelD DrainTypeDefinitions
2 | VehicleID VehicleDefinitions
3 | StreamConnectID StreamConnectDefinitions
4 | BroadBaseDipTypelD BroadBaseDipTypeDefinitions
5 | SlopeShapelD SlopeShapeDefinitions
6 | DischargeTolD DischargeToDefinitions
7 | ObstructionID ObstructionDefinitions
8 | FillErosionID FillErosionDefinitions
9 | BroadBaseDipConditionID | BroadBaseDipCondDefinitions
10 | MateriallD MaterialDefinitions
11 | DitchReliefTypelD DitchReliefTypeDefinitions
12 | DitchReliefConditionID DitchReliefCondDefinitions
13 | FlowDiversionlD FlowDiversionDefinitions
14 | FlowDiffuserID FlowDiffuseDefinitions
15 | LeadOffConditionID LeadOffCondDefinitions
16 | NonEngConditionID NonEngCondDefinitions
17 | StrXingTypelD StrXingTypeDefinitions
18 | PipeDimID PipeDimDefinitions
19 | PipeNumberID PipeNumberDefinitions
20 | StrXingConditionID StrXingCondDefinitions
21 | ChannelAngleID ChannelAngleDefinitions
22 | BlockTypelD BlockTypeDefinitions
23 | SubstrateID SubstrateDefinitions
24 | DebrisFlowID DebrisFlowDefinitions
25 | DiversionlD DiversionDefinitions




26 | SumpConditionID SumpCondDefinitions

27 | WaterBarTypelD WaterBarTypeDefinitions
28 | WaterBarConditionID WaterBarCondDefinitions
29 | RoadNetworkID RoadNetworkDefinitions
30 | RoadTypelD RoadTypeDefinitions

31 | SurfaceTypelD SurfaceTypeDefinitions
32 | SurfaceConditionID SurfaceConditionDefinitions
33 | SurfaceCoverID SurfaceCoverDefinitions
34 | RoadEdgelID RoadEdgeDefinitions

35 | RoadEdge2ID RoadEdgeDefinitions

36 | EdgeVegetation1ID EdgeVegetationDefinitions
37 | EdgeVegetation2ID EdgeVegetationDefinitions
38 | EdgeCondition11D EdgeConditionDefinitions
39 | EdgeCondition2ID EdgeConditionDefinitions
40 | FlowPathVeglID FlowPathVegDefinitions
41 | FlowPathVeg2ID FlowPathVegDefinitions
42 | FlowPath1ID FlowPathDefinitions

43 | FlowPath2ID FlowPathDefinitions

44 | FlowPathCond1ID FlowPathCondDefinitions
45 | FlowPathCond2ID FlowPathCondDefinitions
46 | FillChannellD FillChannelDefinitions
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APPENDIX 3

TauDEM Stream Network Shapefile Attribute table
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The TauDEM stream network delineation function produces a stream network

shapefile with the following attribute table.

Field Description

LINKNO Link Number. A unique number agsociated with each link
(segment of channel between junctions)

DSLINKNO Link Number of the downstream link. -1 indicates that this does
not exist.

USLINKNOI Link Number of first upstream link

USLINKNO2 Link Number of second upstream link.
Node identifier for node at downstream end of stream reach. This

DSNODEID identifier corresponds to the "id" attribute from the Outlets
shapefile used to designate nodes.

Order Strahler Stream Order

Length Length of the link

. Shreve Magnitude of the link. This is the total number of sources

Magnitude
upstream
Drainage area at the downstream end of the link. Generally this is

DS Cont Ar one grid cell upstream of the downstream end because the drainage

- - area at the downstream end grid cell includes the area of the

stream being joined.

Drop Drop in elevation from the start to the end of the link

Slope Average slope of the link (computed as drop/length)

Straight L Straight line distance from the start to the end of the link

US Cont Ar Drainage area at the upstream end of the link
Watershed number. Cross reference to the *w.shp and *w grid

WSNO files giving the identification number of the watershed draining
directly to the link.

DOUT END Distance to the outlet from the downstream end of the link

DOUT_START Distance to the outlet from the upstream end of the link

DOUT MID Distance to the outlet from the midpoint of the link

The following fields that record sediment inputs to the stream network and habitat patch

clusters are added to the TauDEM stream network shapefile by the GRAIP model.

Field

Description

SedAccum

Accumulated upstream sediment load from road surface at the
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downstream end of each stream segment (kg/yr)

Direct sediment input from road surface to each stream segment

SedDir (ke/yr)
Specific sediment accumulation to each stream segment defined as
SpecSed accumulated upstream sediment production divided by upstream
contributing area at the downstream end of each stream segment
(Mg/km?*/yr)
SpecSedDir Direct specific sediment input to each stream segment d;Vided by
the direct area draining to each stream segment (Mg/km®/yr)
HabPatchID A unique identifier for each contiguous habitat cluster as

demarcated by fish passage barrier
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APPENDIX 4

GRAIP preprocessor tool tutorial
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Introduction

The GRAIP Data Preprocessor Tool is a software utility developed to validate and
import USFS inventory shapefile attributes into a relational database structure created in
MS Access file format. The purpose of this database (the GRAIP Database) is to enforce
referential integrity and ensure consistency between related attributes. The tool helps to
screen out invalid or corrupt data and provides the user with a better dataset to continue
with forest road impact analysis. It also consolidates multiple drain point and road line
shapefiles and creates a single shapefile for each. This appendix presents a tutorial

example to illustrate the working of the GRAIP Database Preprocessor tool

Getting started

The setup file required for running the tool can be downloaded from

www.engineering.usu.edu/dtarb/graip. The GRAIP tool setup is called

“GRAIPSetup.exe” and it includes a sample dataset in a zipped file (*.zip) format named
“demo.zip”. This zip file contains a tutorial folder which contains the “dem” (ESRI
Raster Grid) file and a shapefiles folder containing eight types of drain points shapefiles
(BBdip.shp, Diffuse.shp, Ditchrel.shp, Lead off.shp, ned.shp, Str Xing.shp, sump.shp,

waterbar.shp) and one road lines shapefile (road.shp).

Download GRAIPSetup.exe and save it to your working folder. Double click to
run the setup. This will install GRAIP in the designated folder (by default C:\Program

Files\GRAIP)

The GRAIP installation includes
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1) GRAIPPreprocessor.exe, consolidateShp.dll, agGRAIP.dIl and

graipCOMDLL.dIl: An executable and binary libraries.

2) GRAIP.mdb: Template database in folder "graip db".

3) A tutorial folder that contains tutorial documentation and zipped
demonstration data.

4) A shortcut to the GRAIP Database Preprocessing tool will be created on

the in the Start-> Programs menu

GRAIP database preprocessor

Start the GRAIP Database Preprocessor Tool by clicking the windows “Start”
button and going to the All Programs -> GRAIP menu and clicking GRAIP Database

Preprocessor icon. The File Definition screen will be displayed as shown in Figure 1.
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Define Files

[*| Pre-process @

GRAIP Preproceszor iz a tool to impart S0 Forest Service road inventony information inko a M5 Access
databaze.

Project File

| D:\demahtest.graip ||

Input Files
DEM File ["zta.adi" inzide the DER Folder)

| D:ADEMONDEMAde L.

Road Shapefiles

D:ADEMONS hapeFileztRoad.shp Add

Drain Points Shapetiles

5 @& 066

O:ADEMONShapeFilez BB dip.shp ) Add
D:ADEMOMNShapeFilezhDiffuse. shp
D:ADEMOMNShapeFileshDitchB el shp Del
D:ADEMONShapeFilestLeadOff.shp
O:ADEMONShapeFileshMed. shp
D:'xDEMEI"-.ShapeFiIes"-.Str_King.shp v
GRAIP Database [*.mdb]
D:Hdemu\test.mdb‘g
Options LCancel | Mest » |

Figure 1: File Definition Screen.

1. Start by unzipping demo.zip file to working folder (eg:- C:\demo).

2. Click on the More Button (...) next to the Project File field of test.graip. In the
Save Project dialog select a folder and enter a file name for the new GRAIP
Project file to be created

3. An initial path and file name for GRAIP Database file (E) will be generated based

on the path and file name selected in step 1.
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4. Click on the More button (...) next to DEM file field (B). Browse to the

working folder and select the dem\sta.adf file and click “OK”. Figure 2 shows the

location of the DEM sta.adf file used in this example.

Select Folder

File name: Folders: 0k
|Sta_adf d:\dematdembdem _
Cancel
dblbrd. adf [== d:
hdr. adf = demo
rj. adf = DEM
wO01007. adf = dem
wO07007 . adf
Lizt files of type: Dirives:
|DEM File[* adf] x| | B dMyLie | Network..

Figure 2: The “Select Folder” dialog shown when the More (...) button next to the
“DEM File” field is clicked

5. Click on the “Add button adjacent to Road Shapefiles field (C). Select the
\Program Files\GRAIP\tutorial\Demo\Shapefiles\Road.shp file and click “OK”.

6. Click on the “Add” button adjacent to Drain Points Shapefiles field (D). Select the
\Program Files\GRAIP\tutorial\Demo\Shapefiles\ directory. Select the following
files from that directory by holding down the “Ctrl” key and clicking on each
filename in the File name list: BBdip.shp, Diffuse.shp. DitchRel.shp,
LeadOff.shp, Ned.shp, Str Xing.shp, Sump.shp, WaterBar.shp. Release the “Ctrl”
key and click on “OK”.

7. Click the “Options” button to change Message options. (See Figure 3). If you

choose to override the error messages the program will run to the end accepting
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the default choices for field matches and resolving undefined values. This is

useful if a user knows the defaults are satisfactory.

8. Click “Next”.

9. You should see that a new GRAIP project file (TBtest.graip) has been created
which holds the information about the file paths. A new MS Access database file
(TBtest.mdb) should also have been created at the specified GRAIP Database
path. All the shapefile attributes will be validated and stored inside this database

file.

Error Meszage
o Show Meszage [Default]

" Over ride ermor meszages
-
Log Filez

Dirain Paint

| D:MvdemostestDPlog

Foad

Cancel | Set |

Figure 3: Options dialog to over ride error message and change the paths and/or file
names of the log files

Import Drain Points Attributes

The Drain Points Import Screen is shown in Figure 4. (A) displays the path of the
drain point shapefile to be imported from the shapefiles selected earlier. (B) shows
the Drain point type which is automatically selected by the program based on the

name. This can be changed if necessary. (C) displays the table with Target Fields that
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will be populated in TBTest.mdb and Matching Source fields from the shapefile.

The tool will match the fields by default.

1. Click on the row in the Matching Source Field column to change any default
fields that are not correctly matched automatically (See Figure 5). If a matching
field is not found “<No Match Use Default>" is selected by the tool.

2. Once you are satisfied with the matches click “Next”.

[~ Preprocessor:1 of 9 @

katch a zource field from the input file to the appropriate target field in the databasze table

Imputs from drain point file VR
| e )

Set Field Mames

Dirain Point Type B
Broad baze dip -

For each target field zelect the zource field that zhould be loaded into it.

T arget Field k atching Source Field @
CDate <MNao Match Use Default
CTime <Moo Match Use Default:
YehiclelD <MNao Match Usze Defaults
CrainlD CRAIM_ID
StreamConnectlD STREAKM_COM
Commerts COMMEMNT
BroadB azelipT ypelD Tv'PE Z

Figure 4: Drain Points Validate and Import dialog.
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[~| Preprocessor:1 of 9

bl atch a source field from the input file to the appropriate target field in the database table

|mputs fram drain point file

Set Field Mames

Drain Paint Type
Broad baze dip ﬂ

For each target field zelect the zource figld that should be loaded inta it.

T arget Field b atching Source Field R
Chate <Mao Match Use Default:
CTime <Mo Match Uze Default:
WehiclelD <Mo Match Uze Default:
DrrainlDr DRAIM_ID
StreamConnectiD STREAM_CON j
Camments DISCHRG T -
- STREAM COM
Broadk azeDipT ypelD OESTRUCT -
|FILL_ERDOS
TvPE
CONDIT ¢Back [ New> |
MATERIAL
| COMMEMT et

Figure 5: Selecting the Matching Source Field.

3. If an attribute value is found which is invalid or misspelled, an Attribute Validate
dialog is displayed (See Figure 6). In that case either “reassign the value to an
existing preferred value in definitions table” or “Add new entry to preferred value
definitions table” or “Use default” and click “OK”. ”. This information is added to

the DPErrorLog table to verify later.



Add New Definition
Yalue 'Previouz' in field 'FlowDiversionl D not in defaulk definitions.

i+ Reazzign thiz value to an existing table definitions entry

Drefiritions

~

" Add new entry to definitions table

Definition Table |

ID|

D efinitiar |F"reviu:nus

Cescription |F"re'...'i|:|u3

Cancel | Ok |

Figure 6: Attribute Validate dialog.
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4. Once all of the invalid values in that drain point table are processed, the next drain

points validate and import screen is displayed. Continue these steps until all the

drain points are imported to the database.

5. Once all the drain points shapefiles are validated and imported, the Road Lines

import screen is displayed.

Import Road Lines Attributes

The Road Lines Import screen will be displayed as shown in Figure 7. (A)

displays the path of the road lines shapefile to be imported as selected earlier. (B)

shows the Road Network Type. This can be changed if necessary. (C) shows the Base

Rate associated with the road network type. (D) shows the Description for the base
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rate used. (E) shows the “+” button to add a new type of road network, associated

base rate and the description for the base erosion rate. The “-* button is to remove a

road network type record and its associated base erosion rate. The user does not have

the permission to remove the “Default” road network type record. (F) displays the

table with Target Fields that will be populated in TBTest.mdb and Matching Source

Fields from the shapefile. The tool will match the fields by default.

1. Click on the row in the Matching Source Field column to change the default fields
matched (Figure 8).

2. If a matching field is not found, “<No Match Use Default>" is selected by the
tool.

3. Once you are satisfied with the matches click “Next”.



[~ Preprocessor: 9 of 9

Foad Line

Match a source field from the input file to the appropriate target field in the databaze table @

Set Field Hames .
Baze Eros te
Road MNetwork @ [kga’m;’yr]@ Dezcription

Drefault ﬂ | |

For each target field select the source figld that should be loaded inta .

Target Field bl atching S ource Field
CDate <Moo Match Use Default:
CTirne <Mo Match Use Default:
YehiclelD <Mo Match Use Default:
OrigSourceCode FID_1
RoadTppelD FOaD_TYPE
GRAIPDIDT 1_Drain_|D
GRAIPDID2 2_Drain_|D

Figure 7: Road Lines Import dialog




[~| Preprocessor: 9 of 9

Foad Line

bl atch a source field from the input file to the appropriate target field in the database table

Set Field Mames
Foad Metwark:

Baze Erozion Fate
[kadmdyr]

Drefault

Drescription

=1 |

For each target field zelect the zource figld that should be loaded inta it.

[

< Back | Mest » |

Target Field M atching Source Field
CDate <Mo Match Uze Default:
CTime <Mo Match Uze Default:
YWehiclelD <Mo Match Use Default:
OrigSourceCode FID_1
FioadTypelD ﬂ
GRAIFDID <Mo Match Use Default: A
FID_1
GRAIPDIDZ SURF_TPE
SURF_COMD
RD_EDGE_1
RD_EDGE_2
| EDGE VEG 1 o

Figure 8: Selecting the Matching Source field.
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4. 1If a Value is found which is invalid or misspelled an Attribute Validate dialog is

displayed (See Figure 9)

5. In that case either “reassign the value to an existing value in preferred value

definitions table” or “Add a new entry to definitions table” or select “Use Default

Value” and click “OK”. This information is added to the RDErrorLog table to

verify later.



Add New Definition
Yalue '0-20" in field 'FillChannelD' nat in default definitions.

i+ Reazzign thiz value to an existing table definitions entry

Drefiritions

~

" Add new entry to definitions table

Definition Table |

ID|

D efinition ||:|.2|:|

Description ||:|.2|:|

Cancel | Ok |

Figure 9: Attribute Validate dialog
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6. Once all the Road Line attributes are imported to the database, the tool checks for

drain points without any road segments draining to it and road segments that do

not drain to any drain point. These are referred to as orphans Identifiers of drain

points and road segments are stored in the error log tables and text files.
DPErrorLog, RDErrorLog for drain points and road segments respectively.

7. The consolidate shapefiles progress bar will appear while the shapefiles are

consolidated.

GRAIP Database Preprocessor Tool Output Files

Figure 10 gives a list of the output files created by the GRAIP Database Preprocessor

tool.



Mame £ Size I Tvpe I |
1DEM File Folder '
3 shapefiles File Faolder
CrainPoints ., dbf 4 KB Microsoft Visual Fox,.,,
CrainPaoinks.shp 10KE SHP File
CrainPoinks, sh 3KB SHx File
Roadlines, dbf A0 KB Microsoft Yisual Fox...
RoadLines.shp 2,428 KB SHP File
RoadLines. shx 65 KB  SHE File
@test.mdb 10,936 KB Microsoft Access Ap...
best.rsap 1KE RSAP File
E kestDP.log 1KB Text Document
testRO.log 7EKB  Text Documnent

Figure 10: GRAIP Database Preprocessor Tool output files
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APPENDIX 5

GRAIP GIS Tool Tutorial
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GRAIP GIS model is an ArcGIS 9.1 toolbar developed to analyze the impact of
forest roads on forest watersheds. This tutorial describes how to install and use the set of
tools needed to perform a GRAIP analysis. These tools consist of the GRAIP

Preprocessor, GRAIP GIS Tool, SINMAP2.0, TauDEM and Hawth's tools.

Installation

1. TauDEM: The website http://hydrology.neng.usu.edu/taudem/ explains

how to install and use the TauDEM toolbar.

2. SINMAP2.0: The website http://hydrology.neng.usu.edu/sinmap2

explains how to install and use the SINMAP toolbar.

3. Hawth's Tools: The website http://www.spatialecology.com describes how

to install and use Hawth's analysis tools.
4. GRAIP and GRAIP Preprocessor: The website

http://www.engineering.usu.edu/dtarb/graip provides a link to the GRAIP

tool setup file: “GRAIPSetup.exe”. Download GRAIPSetup.exe and save
it to your working folder. Double click to run the setup. This will install
GRALIP in the designated folder (by default C:\Program Files\GRAIP).
This includes both the preprocessor and ArcMap toolbar. Use of the

preprocessor is described in a separate preprocessor tutorial.
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Getting started

To activate the GRAIP toolbar open ArcMap, go to the “Tool” menu and click

“Customize” dialog, Figure 1, should open.

Customize

Toolbars | Commands ] Optians ]

Toaolbars:

[ Diszonnected E diting |
Ciraw
Editar |

[
=
[n1]
=

[] Effects

[1GPS

[1 Geametric: Metwark E diting
[1 Geareferencing

[1 Geostatiztical Analyst

[] Graphics

[1Labeling

Layaut

[1Map Cache

[1 Metwark Analpst b

Kevboard... Add fram file...

Figure 1: ArcMap Tool Customize dialog.
Click “Add from file...” and browse to \Program Files\GRAIP and select the
agGRAIP.dII file. Check the “Geomorphologic Road Analysis and Inventory Package”

box (Figure 2) to make the toolbar (Figure 3) visible.
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Customize

Toolbars | Commands ] Optiong ]

Toolbars:

Editor A Mew... |

[] Effects

[1GPS |
|

[1 Geometric Nebwork Editing
Geomarphologic Boad Analysis and Inventon Pack,

[] Geareferencing Reset
[| Geomarphologic Road Analysis and Inventory Package(GRAIF) 1L1
[] Graphics

Hawth's Toolz

[1 Labeling

Lapout

[ Map Cache

[1 Metwark Analypst v

Kevboard... Add from file...

Figure 2: Check box to display GRAIP toolbar.

Geomorphologic Road Analysis and Inventory Package{GRAIP)

File * Preprocessor ™  Road Surface Erosion Analysis ™ Mass \Wasking Potential Analysis ¥ Habitak Segmentation Analysis * ¥ (’

Figure 3: GRAIP ArcMap Toolbar.

Toolbar overview

The GRAIP toolbar functionality is divided into following parts (Figure 3)

1) Project settings file management (A).
2) Database preprocessor (B).
3) Road surface erosion analysis to quantify sediment production from forest roads

and its delivery to streams (C).
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4) Mass wasting potential analysis to quantify the impact of forest roads on
terrain stability and gullying potential (D).
5) Habitat segmentation analysis to analyze and demarcate fish habitat segmentation
due to failed or blocked culverts (E)
In addition to above features there are two extra tools to trace the road segments draining
to a particular drain point (F) (Drain Rex, Rex being the faithful dog to sniff out where
road segments drain) and to find drain points where a particular road segment is draining

to (G) (Road Rex).

The following sections in this tutorial describe the steps taken in a typical GRAIP

analysis.

Data preparation

1) Run the GRAIP Database Preprocessor tool
2) Run TauDEM Basic Grid Analysis and Network Delineation functions to delineate a

TauDEM stream network.

Running the GRAIP GIS tool

The *.graip file created by the GRAIP database preprocessor contains information about

input file paths for GRAIP GIS model.

1) From within ArcMap open the *.graip file by going to “File” -> “Open” in the

GRAIP Toolbar (Figure 4). Browse to and select the *.graip file. The DEM,
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DrainPoints.shp, RoadLines.shp and demnet.shp files required for the analyses

will then be displayed in ArcMap (Figure 5).

Geomorphologic Road Analysis and Inventory Package(GRAIP) X

File * Preprocessor > Rioad Surface Erosion Analysis = Mass Wasting Potential Analysis = Habitat Segmentation Analysis = 4 (’

Save

Save as..,

File Management

Figure 4: File Open Menu to open the Project settings file.

Table of Contents X
EEzd avers|

- CrainPoinks
@
- RoadLines

- demnet

- dem
Walue
High : 2478.52

Low : 1046.67

Display |S|:uur|:eJ Seleu:tiu:un]

Figure 5: ArcMap Table of contents showing GRAIP analyses input files loaded.
When the *.graip files is used to load files the RoadLines and DrainPoints shapefiles
are joined to the corresponding in the GRAIP Database (*.mdb) so that attributes are

accessible (Figure 6).



B Attributes of Roadlines

| RoadLines.FID | RoadLines.Shape | RoadLines,

RoadLines.RoadEdge2ID RoadLines.Edg 11D RoadLines.Edg

H 0 |Polyline 0 3 1 1
H 1 |Polyiine 1 E 1 1
J 2 |Polyline 2 3 1 1
H 3 |Polyline 3 3 1 1
H 4 |Polyline 4 3 1 1
* 5 |Palyline 5 3 1 1

| & |Palviine & 3 1 1
2 | >
Recond: ﬂﬂ B ﬁ » Shaowr W Selected | Records [0 out of 1025 Selected.) Optiohs =

Figure 6: RoadLines shapefile attribute table joined to MS Access RoadLines table.

2) To manage the file paths for input, intermediate and output files, go to File ->

File Management menu to open the File Management Dialog (Figure 7)

| test Properties

|nput Files

Basge Inputs l Intermediate Files and Dutputs] Field Mames ]

DEM File

|D:ADEMONDEM dem

Fioad Shapefiles

|DZ"-.I:|EI'I'II:I"-.H nadLinesz. shp

Drrain Paints Shapefiles

|DZ"-.I:|EI'I'II:I"-.D rainiFoints. shp

FiSakd D atabaze Folder [*.mdb]

|D:"-.|:Iem|:|'\test.mdl:|

X]

Canicel

Figure 7: Base Inputs file information in File Management Dialog.
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3) Select the Resample DEM function from the GRAIP Preprocessor menu. This

function (Figure 8) resamples a DEM to a finer scale using the cubic convolution

method from the ArcGIS Toolbox.

. Resample E'
[nputs
[rput DE R
[DDEMONDEMden J
Output Cell Size 5

Output Fine Scaled Pits Filled Digital Elewvation kodel
D:\DEMONDEMAdermr J

Cancel | Compute |

Figure 8: DEM Resample Function Dialog.

4) Select the Extract Stream Crossings function from the GRAIP Preprocessor menu.
This function extracts the stream crossing drain points from the consolidated
DrainPoints shapefile created by the Database Preprocessor tool.

5) Use the Hawth's Tools -> Vector Editing -> Intersect lines (make points) function to
intersect the Road lines with the preliminary stream network. Name the output

StrXingRi.shp (Figure 9).
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H [ Intersect Lines (Make Points) E]@

[Fput

| RoadLines j
-

[ Retain attributes from this lawer

Line/poly layer:

Interzect linedpaly layer: | demnet ﬂ
Cukput

Output point zhapefile:

D:hdemohStixingRi shp i

[w Add output layer to Arckdap after processing

weh Help 0K | Esit |

i

Figure 9: Hawth's Intersect Lines Tool Dialog.

6) Snap stream crossings to the preliminary stream network. Use Hawth's Tools ->
Vector Editing -> Snap points to lines tool to snap the extracted stream crossings
shapefile to the nearest position on the TauDEM stream network shapefile resulting in

a new point shapefile (StrXingSn.shp) (Figure 10).

H Snap Points To Lines E'
[rput
Pairt feature layer: |Str><ingE:-c ﬂ
Lirne or polpgon feature layer: |':|'3""'”'E’t ﬂ
Parameters
Search tolerance diztance [in map unitz]: 1000
Cukput
Mew point layer to create:;
|D:'\dem-:u"-.5tr.‘><ing5n.shp @
‘Wb Help | 0K | Exit |
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Figure 10: Hawth's Snap Points to Lines Tool Dialog.

7) Filter Stream Crossings. Use GRAIP -> Preprocessor -> Filter Stream Crossings
function to automatically associate the appropriate points on the stream network from
the snapped stream crossings (StrXingSn.shp) and road stream intersections
(StrXingRi.shp) with nearby surveyed stream crossings screened according to
nearness and a geomorphologically derived channel width criterion (Figure 11). The
output is three shape files containing all merged stream crossings (MergedSX.shp),
matched stream crossings (MatchSX.shp) and unmatched stream crossings

(UMatchSX.shp).
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| Filter Stream Crossings

Input
Extracted Stream Crozsings

|D:"«demu:u"~5tr><ingE:-:.shp
Hawth Shapped Stream Crozzing Shapefile

-]
|D:'\|:Iem|:|'\.5 ti<ingSn.zhp J
L
]

Hawth Road Stream Intersection Shapefile

|01 demotS tixingRii. shp
Contributing Area Grid

|D:"~DEMD'\DEM"-.cIemacIE

Filter Cntena

l[Chan_‘width - Geolwl[Chan_\Width+Geolw) / 2 <= | 03
Mearest Stream Crozzing Diztance [m) <= | 100
Dutput
berged File
|D:'\demu:u"-.MergedS><.shp J

katched Stream Croszsings Shapefile

|D:4demaMatchSi, shp

nmatched Stream Crozsings Shapefile
[0 dematUMatchS, shp .

Cancel | Compuite |

Figure 11: Filter Stream Crossings function.

8) Check matched and unmatched on-stream points, manually editing and resolving
mismatches where possible or identifying situations requiring further examination in
the field. The goal of the filter at the step above was to position each surveyed stream
crossing from StrXingEx.shp on the stream network. This was attempted by
examining both the nearest position on the stream to which the stream crossing can be
snapped (StrXingSn.shp) and the nearest road stream intersection (StrXingRi.shp).
Points where one of these passed the matching criteria are in MatchSX.shp. The user

should in most cases be able to accept these without further analysis. The surveyed
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stream crossings for which there was no match found are placed in

UMatchSX.shp. The user should examine each of these to verify why they are not
able to be placed on a stream and make the appropriate edits.

Combine the matched on-stream points shapefile with the overall outlets shapefile
renumbering the Id field to avoid Id duplicates between the on-stream points and
overall outlets. A simple way to combine shapefiles is to start editing the outlets
shapefile, then select all the points in the MatchSX.shp shapefile and copy, then paste
them into outlets.shp. A simple way to renumber the Id field is to use calculate

values to set Id equal to Fid.

10) The combined outlets + stream crossings shapefile is then specified as the outlets

shapefile for running the TauDEM network delineation functions. Use Preprocessor -
> Create TauDEM Stream Network function to run the TauDEM network delineation
function. With the new outlets shapefile as input TauDEM creates a stream network

shapefile with stream segments split at stream crossings.

Road Surface Erosion Analyses

The functions on the GRAIP toolbar menu “Road Surface Erosion Analysis” (Figure 12)

should be run in sequence from top to bottom.
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Geomorphologic Road Analysis and Inventory Package{GRAIP) ]

File  Preprocessor ™ |Road Surface Erosion Analysis ™ Mass Wasting Potential Analysis ¥ Habitat Segmentation Analysis * @ (’

Road Segment Sediment Production

D ain Poink Sediment Accurmulation
Accumulated Upstream Sediment Load

Accumnulated Upstream Specific Sediment

pstream Stream Sediment Input

Direct Stream Sediment Input

Figure 12: Road Segment Sediment Production Menu
1) Road Segment Sediment Production: Use Road Surface Erosion Analysis -> Road
Segment Sediment Production function to calculate the sediment production
values at each stream segment. Road Segment Sediment Production Analyses tool

dialog is opened (Figure 13)

. Road Sediment Production

[nputs
Road Shapefiles

|D:'\u:|em-:n"~F| aadLines. shp

Interpolated Digital Elewvation kModel
D\DEMO\DEM e J

Output
The Fieldz SedProd_1 [kgdw], SedProd_2 [kadw], Length [m], UnitSed [ka/mdw], Slope will be appended
to Foad Lines table

Cancel

Figure 13: Road Sediment Production tool dialog.
Click compute to calculate sediment production values. The following fields are

populated in the RoadLines table in the GRAIP database (*.mdb file)

a) Length : Road length (meters)
b) SedProdl: Sediment production from one side of road (kg/yr)

¢) SedProd2: Sediment production from other side of road (kg/yr)



d) UnitSed: Unit sediment production from the road segment (kg/m/yr)

e) TotSedProd: SedProd1+SedProd2 (kg/yr)

f) TotSedDel: Sediment delivered to streams (calculated using stream
connection information for each road) (kg/yr)

g) UnitTotSedDel: TotSedDel/Length (kg/m/yr)
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2) Drain Point Sediment Accumulation: Use Road Surface Erosion Analysis ->Drain

Point Sediment Accumulation function to open the tool dialog (Figure 14)

| Sediment Accumulation at Drain Points E|E|E|

Inputs
Road Shapefiles

|D:"~demn:|'xH aadlines. shp

Dirain Pointz Shapefiles

|D:"u:|emn:n'\DrainF'n:-ints.shp

Output

The Fieldz SedProd [kadw], UnitSed [kodmder] and ELength [Effective Length in m) will be appended to
the DranPaoints table in GRAIP D atamadel.

Cancel | Compute |

Figure 14: Drain point sediment accumulation tool dialog.

Click the compute button to calculate and store sediment accumulation values at each

drain point in the DrainPoints Table in the GRAIP database.

The following drain point fields are populated

a) SedProd: Total accumulated sediment load at each drain point due to road

surface erosion (kg/yr)

b) ELength: Effective length of road draining to each drain point (meters)

c) UnitSed: SedProd/Elength (kg/m/yr)
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d) SedDel: Sediment delivery depending on stream connection (kg/yr)

4) Accumulated Upstream Sediment Load: Use Road Surface Erosion Analysis->
Accumulated Upstream Sediment Load function in the GRAIP toolbar to open

the tool dialog (Figure 15)

| Accumulated Upstream Sediment Load

Input
Drain Pointz Shapefiles

|D:"u:|emu:u"~D rainiFoints. shp
D3 [default]/Dinf Flow Direction

|D:HDEMD&DEM'\demp

(* Stream Connected € Tatal Sediment Production

Output
Sediment Production wWieight Grid.

\D:\DEMOADE M demswit
Accumulated Upstream Sediment Load.

D:ADEMOADEM\demsac

(o |ze D8 Contributing Area Function i Use Dinf Contributing Area Function
[v Add Layers to the Map Cancel | Compute |

Figure 15: Accumulated Upstream Sediment Load dialog with default file names and
options.

Click the compute button and following output grids are created.

a) Weight grid with Drain Point accumulated sediment load (swt suffix)
b) Weighted Sediment Accumulation grid (sac suffix). The user can select
between D8 and Dinf Contributing area functions.
5) Accumulated Upstream Specific Sediment: Use Road Surface Erosion Analysis->
Accumulated Upstream Specific Sediment function to open the tool dialog (Figure

16)



| Specific Sediment Accumulation
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Output

Accumulated Upstream Sediment Load.

\D:ADEMOADEM\demsac

| pstream Contributing Area

|D:"~DEMD'\DEI‘-1"-.|:IemadB

Output

Specific Sediment Accunmulation

D:\DEMONDEM\demspe

[v Add Laver to the Map

Cancel

L
| Compuite |

Figure 16: Specific Sediment Accumulation Dialog with default file names. User has the
option to change input and output file names.

Click compute to create upstream specific sediment accumulation grid (Suffix spe)

6) Upstream Stream Sediment Input: Use Road Surface Erosion Analysis->

Upstream Stream Sediment Input function to open the tool dialog (Figure 17)
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i, Accumulated Upstream Sediment Load For Stream Hetwork

Input
Fit Filled DER

|D:"~DEI'-1EI"~DEM'\|:IemfeI

Accumulated Upstream Sediment Load.

|D:ADEMONDEM demsac
| pstream Contributing Area

|
]
|

Stream Metwark,

|D:'\DEI‘-1EI"~DEM"~|:Iemnet.shp

Output
The Figldz Sediccun and SpecSed will be appended ta the Stream netwark, attribute table.

Seddcoum containg sediment load far the downstream end of each stream zegment in kgl
SpecSed containz sediment load per unit area of the downstream end of each stream segment in

b gy o
Cancel | Compute |

Figure 17: Accumulated Upstream Sediment Load for Stream Network with default file
names and paths.

Click the compute button to calculate the upstream sediment inputs and specific

upstream sediment inputs to each stream segment. Outputs from this function are

a) SedAccum: Accumulated Sediment Inputs to each stream segment (kg/yr)
b) SpecSed: Accumulated Specific Sediment load in each stream segment
(Mg/km?/yr)
These are appended to the stream network shapefile (*net.shp)
7) Direct Stream Sediment Input: Use Road Surface Erosion Analysis->Direct Stream

Sediment Input to open the tool dialog (Figure 18)
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. Direct Sediment Production-Stream

Input
Pit Filled DE M

|D:HDEMD'\DEM"-.cIemfeI

Accumulated Upzstream Sediment Load.

D:\DEMONDEM\demsac

|D:"~DEMD'\DEM"-.cIemacIE

Strearm Metwark,

]
5 =
|Ipztream Contributing Area
L
]

|D:HDEMD'\DEM"-.::Iemnet.Shp

Output

The Fieldz SedDir and SpecSedDir will be appended to the Stream network. attribute table.

SedDir containg sediment load for the area draining directly to each stream zegment in kaor.
SpecSedlir containg sediment load per unit area draining directly to each stream segment in b ogderdmé

Cancel | Compuite |

Figure 18: Direct Stream Sediment Input dialog with default file path.
Click the compute button to calculate the direct upstream sediment inputs and direct
specific upstream sediment inputs to each stream segment. Outputs from this function

arc

a) SedDir: Direct Sediment Inputs to each stream segment (kg/yr).
b) SpecSedDir: Direct Specific Sediment load in each stream segment
(Mg/km?/yr).

These are appended to the stream network shapefile (*net.shp).

Mass Wasting Potential Analysis

The functions on the Mass Wasting Potential Analysis Menu (Figure 19) should

be run in a sequence from top to bottom
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Geomorphologic Road Analysis and Inventory Package{GRAIP) [x]

Filz

Preprocessor ¥ Road Surface Erosion Analysis ™ | Mass Wasting Potential Analysis *  Habitat Seqmentation Analysis * @ r"

Figure

1)

=
Input

Stability Index

Select Calibration Region Grid
Combined Stability Index

D& Slope with downslope averaging
Slope at Drain Paink

Erosion Sensitivity Index

Length Slope Plat

Stream Blocking Index

19: Mass wasting potential Analysis menu.

Stability Index: Use Mass Wasting Potential Analysis -> Stability Index function
to open the tool dialog (Figure 20). Before doing this function you have to run
SINMAP 2.0 to create the Stability Index (SI) grid. This SI grid is used as input in
this function. For more information and tool documentation on SINMAP 2.0

please visit http://hydrology.neng.usu.edu/sinmap2/

X]

Dirain Points Shapefiles

|D:Hdemn"~DrainF’u:uints.shp

|D:'\DEMEI"-.DEMHSINM.&PData'\demsi
Output
1] The field 5l iz appended to the table of the Drain Point Shapefile(z). Stability Index at each drain point

eztimated fraom SIMMAP output interzected with the drain point feature clazs locations.

Cancel

Figure

20: Stability Index at each drain point.
Click compute to identify Stability Index grid values at each drain point and store

them in the DrainPoints table. The SI field is populated with values
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2) Combined Stability Index: This function requires a calibration grid to run.
Calibration regions are areas within which single lower bound and upper bound
calibration parameters values can represent T/R, dimensionless cohesion, friction

angle (¢) and soil density (p). SINMAP 2.0 tool documentation at

http://hydrology.neng.usu.edu/sinmap2/ gives more information on creating the

calibration region grid. To load the Calibration grid, click use Mass Wasting
Potential -> Select Calibration Grid function and browse to the calibration grid.
The grid is added to ArcMap when you select the grid. Now you can run
Combined Stability Index using Mass Wasting Potential -> Combined Stability
Index function. A tool dialog with default parameters and input and output file

names will open (Figure 21)
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i, Combined Stability Index @

Input
Dirain Points Shapefiles

|D:‘~demn'\DrainF‘nints.shp

Road Shapefilez

|D:"u:|em|:|"aFE oadLines. shp
Specify Boad ‘width [m]

| J Calibration Farameters Test File

|D:HDEMDHDEMHdemcaIp.csv J
Yiew/Edit Calibration Parameter File |

kinimum T errain Recharge [mdhr] bl awimumm T errain Fecharge [m/hr]

| 0.0003 | 0.00135

Finirmum Additional Foad Surface Bunoff [mdhr) b awimum Additional Road Surface Bunoff [mehr]

| 0.001 | 0.002

Dinf Slope

|D:"-.DEMEI"~DEMH::|emst

Dinf Specific Catchment Area

|D:'\DEMEIHDEMH::Iems-:a
Calibration Grid

Lk

|D:'\DEI‘v1EI‘-.DEI'v1'\dem|:aI

Output
Combined Stahbility |ndex Grid

|D:'xDEMEI"~DEM'x-:Iemsi|:

1] The field SIR iz appended to the table of the Drain Point Shapefile(z). Boad Stability Index at each drain
point estimated from SIMMAP output intersected with the drain point feature clazs locations.

[v idd Sl combined arid to the Mag Cancel | Compute |

Figure 21: Combined Stability Index function.
Minimum and Maximum Terrain and Road recharges are user adjustable. Click
View/Edit Calibration Parameter file button to open the table with modified SINMAP

parameter values (Figure 22). These parameters are user adjustable.
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B Parameter ¥alues Of the Calibration Grid E|@|E|
W alue Feqion Trnir Trnax Crmir Crnax PHIrnin PHIrmnax Rhos
1 Reqion 1 2708 2708 1] 025 30 45 2000
Save | Cancel

Figure 22: Calibration Parameter Table for single calibration grid selected.

The output and intermediate files created are

a) Minimum and maximum depth of terrain runoff generated (Suffix
rmin and rmax).

b) Specific discharge due to road drainage for Minimum runoff and
Maximum runoff (Suffix rdmin and rdmax ).

c) Combined Stability Index Grid (Suffix sic).

The intermediate outputs (a) and (b) are not added to the ArcMap

In this function stability index (SI) due to terrain contributing area can be
calculated by setting the road surface runoff to be 0 and SI due to road runoff only can be
computed setting terrain recharge to be 0. The SI values from the grid are used to identify

SI values to store in the SIR Field in for each drain point in the GRAIP database.

2) D8 Slope Grid with Downslope averaging: Use Mass Wasting Potential -> D8
Slope Grid with Downslope averaging function to open the tool dialog (Figure
23). Here the D8 flow directions are used to trace downslope and find the average

slope for each grid cell over the specified averaging distance.



201

il 08 Slope Gridwith downslope averaging

Input

Fit Filled DEM

|D:HDEMD'\DEM"~demfeI

D08 Flow Direction

Output

Cowngradient Trace Distance d in Meters |50

D08 Slope Grd with downslope averaging [d]

D:ADEMOSDEMdernp -

|D:'\DEMD'\DEM'\demSIpd

[w &dd Layer to the Map Cancel | Compute |

Figure 23: Slope Grid with downslope averaging function dialog.

3)

The output from this function is the slope grid with downslope averaging (Suffix

slpd)

Slope at Drain points: Use Mass Wasting Potential Analysis -> Slope at Drain
Points function to open the tool dialog. Click compute to calculate the slope at
each drain point (Figure 24). Slope field in the DrainPoints table in GRAIP

database is updated with values.

| Slope At Each Drain Point
Input

Dirain Pointz Shapefiles

|D:"u:|emn:n'\DrainF'n:-ints.shp

D03 Slape Grid with Downzlope averaging [d]

1] The

|D:'\DEMD'\DEM"»demstd

Output

eztimated from the Averaged D8 Slope Grid.

field Slope iz appended to the table of the Drain Paint Shapefile[z].Slope at each drain paoint

Cancel
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Figure 24: Slope at each drain point.

4) Erosion Sensitivity Index: Use Mass Wasting Potential Analysis -> Erosion

Sensitivity Index function to open the tool dialog (Figure 25).

il Erosion Sensitivity Index
Input

Drain Pointz Shapefiles

O hdemotDrainPoints. shp

Exponent alpha 2

Output
1] The field ES| iz appended to the table of the Crain Point Shapefile(z).ES| iz evaluated LS alpha.

Lancel

Figure 25: Erosion Sensitivity Index at each drain point.
This function outputs the ESI values at each drain point: LS* where S is the slope and L

is the Effective length of the road draining to each drain point.

5) Length Slope Plot: Use Mass Wasting Potential Analysis -> Length Slope Plot

function to open the graph dialog with Length on the Y-axis and Slope on the X-

axis (Figure 26)
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o)X

Settings
Par Edit | Statistics L-S PLOT
7l Fegion: 1 -FPaints

w| Region:1 -Lines

105

Effective Lengthirm)
=

102

T IIIIIJIII

101+
oAt b b b bt bbb bl
1 I I I 1 1 1 I I
i} 1 2 3 4 & 5] 7 e 9
Slope (5)
Drain Paoints: 1 Gullies: 1 Land slides: 1

Figure 26: Length Slope Plot.

6) Stream Blocking Index: Use Mass Wasting Potential -> Stream Blocking Index

function to open the tool dialog (Figure 27).

i, Stream Blocking Index @

Input
Drain Pointz Shapefiles

|D:'\demn"-.DrainF'u:uints.shp
Mote: Calculated only for Drain Paints for Stream Crozsing Drain points

Output

drain point.

1] The field SBI iz appended ta the table of the Dirain Point Shapefile. Stream Blocking Index indicates
plugaging zuzceptibility bazed upon the ratio of the pipe diameters ta channel width and zkew angle at each

Cancel
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Figure 27: Stream Blocking Index function calculated at each drain point.

Outputs from this function listed below are populated in the DrainPoints table in

the GRAIP database.

a) SBI: Stream blocking Index indicating plugging susceptibility based
upon ratio of pipe diameters to channel width and skew angle.

b) PipeDiaToChannelWidth: Ratio for pipe diameter divided by channel
width ratio class.

c) SkewAngle: skew angle.

Habitat Segmentation Analysis

1) Fish Passage Barrier: Use Habitat Segmentation Analysis -> Fish Passage Barrier

function in the GRAIP GIS Toolbar to open the tool dialog (Figure 28).

. Fish Passage Barriers

Input
Default Parameters for Fish Pazzage Barrier Calculations
Crozzing Slope Sp [%) Cutlet Drop ODp [ft)

2 0.8

Fipe/Channel \width ratio w'p  Outlet Drop to Pool Depth ratio
|0.75 1125

Crrain Pointz Shapefiles

|D:'\demu:u"-.D rainiPoints. shp

Output

11 The field Barier iz appended to the table of the Drain Paointz Shapefile using criteria for crossings that
reprezent fizh pazzage barers flag stream crozsings that are barmmers.

Cancel

Figure 28: Fish Passage barrier function.
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Click compute to find the fish passage barriers and assign identifier representing the

status of the stream crossing. 0- Clear passage, 1- Partial passage and 2- Blocked.

2) Fish Habitat Segmentation: Use Habitat Segmentation Analysis -> Fish Habitat
Segmentation function to open the tool dialog for demarcating habitat clusters.

Figure 29 shows the dialog for fish habitat segmentation determination.

il Habitat Segmentation

Input
TauDER Stream Metwork, Shapefile

|D:"~DEMEI"~DEM"~demnet.shp J
Screened Stream Crozzing Shapefile Uzed az Outlets in TauDER MNetwark Delineation

|D:4demaMatchS, shp
RSak Drain Points Shapefile

|D:"u:|emn:|"-.D rainPaints. shp J

[ Conzider partially blocked as barrier.

Output
1] Each stream zeqment iz azzigned a unique identifier for each contiguous habitat cluster az demarcated by

fizh pazzage barmers. Thiz attribute will be appended to the stream line feature clazs.

LCancel

Figure 29: Habitat Segmentation Function Dialog.

Click Compute to assign each stream segment a unique identifier indicating which

habitat cluster it belongs to. The habitat cluster identifier is appended to the TauDEM

stream network shapefiles attribute table.
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APPENDIX 6

USEFS land type classes
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Table 1: USFS land type classes used to determine BOISED parameters obtained from
USFS Rocky Mountain Research station, Boise, ID.

Landtype | GEF | Side Slope SDR Disturbed
gradient Width
ABCD 0.80 |5 0.000326 4.06
101 0.80 |5 0.000326 4.06
1012 0.80 |5 0.000326 4.06
1013 0.80 |5 0.000163 4.06
101A 0.80 |5 0.000163 4.06
102 0.80 |5 0.000163 4.06
103 0.80 |10 0.000456 4.24
1031 0.80 |5 8.14E-05 4.06
104 0.80 |15 0.002568 4.54
1042 0.80 |10 0.000761 4.24
105 0.80 |15 0.002568 4.54
1054 0.80 |20 0.017392 4.96
1055 0.80 |15 0.007337 4.54
106 090 |10 0.000364 4.24
1062 090 |25 0.007119 5.5
106B 090 |20 0.003645 4.96
107 1.00 | 40 0.048697 7.84
1071 1.00 | 20 0.008696 4.96
1072 1.00 | 25 0.016984 5.5
108 0.80 |45 0.033215 8.86
109 090 |35 0.019535 6.94
1092 090 |35 0.027907 6.94
1095 090 |35 0.027907 6.94
1099 090 |30 0.012302 6.16
109A 090 |35 0.055814 6.94
109A1 0.90 |50 0.081361 10
109B 0.90 |40 0.029131 7.84
109B1 0.90 |40 0.029131 7.84
109C 090 |45 0.031108 8.86
109D1 0.90 |60 0.147769 12.64
109D2 0.90 |20 0.003193 4.96
109E 090 |45 0.06234 8.86
109G 090 |50 0.051206 10
109G1 0.90 |60 0.073737 12.64
109N1 0.90 |40 0.02554 7.84
110 0.80 |15 0.002568 4.54




110X 0.80 |20 0.006087 4.96
I11TA 0.80 |55 0.075804 11.26
111A1 0.80 |55 0.108291 11.26
111A2 0.80 |45 0.059312 8.86
111A3 0.80 |40 0.02916 7.84
111B 0.80 |55 0.075728 11.26
111B1 0.80 |55 0.075728 11.26
111B2 0.80 |50 0.056896 10
111C 0.80 |55 0.056796 11.26
111C3 0.80 |45 0.031108 8.86
111D 0.80 |70 0.046837 15.76
111D2 0.80 |60 0.036868 12.64
111D3 0.80 |45 0.012443 8.86
111G 0.80 |55 0.090874 11.26
111X 0.80 |75 0.144017 17.5
111X1 0.80 |50 0.042672 10
112 0.80 |55 0.151759 11.26
1121 0.80 |35 0.046604 6.94
113 0.80 |75 0.115329 17.5
1131 0.80 |55 0.037902 11.26
114 0.80 |45 0.029656 8.86
1142 0.80 |40 0.020828 7.84
115 0.80 |55 0.060643 11.26
120A 1.00 | 50 0.068343 10
120A1 1.00 |45 0.049822 8.86
120A2 1.00 |45 0.041518 8.86
120A8 1.00 | 50 0.195266 10
120B 1.10 | 55 0.063612 11.26
120B1 1.20 | 45 0.049772 8.86
120B2 1.10 | 50 0.047792 10
120B3 1.10 |55 0.181748 11.26
120B4 1.10 | 45 0.034841 8.86
120B5 0.60 |50 0.056896 10
120B6 1.10 | 40 0.02447 7.84
120B10 | 0.42 |45 0.049772 8.86
120B13 | 1.10 | 50 0.039827 10
120B14 | 042 | 60 0.098316 12.64
120C 1.10 | 55 0.047709 11.26
120C1 1.10 | 60 0.061939 12.64
120C2 1.10 |55 0.136311 11.26
120C3 1.10 | 65 0.1125 14.14
120C8 1.10 | 60 0.176969 12.64
120C11 | 1.10 | 50 0.035844 10
120C12 | 1.10 | 50 0.035844 10
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120D 1.10 |70 0.14051 15.76
120D2 1.10 | 75 0.120975 17.5
120D3 1.10 | 65 0.1125 14.14
120D4 1.10 | 65 0.225 14.14
120E 1.20 | 30 0.014366 6.16
120E1 1.20 |45 0.029034 8.86
120E2 1.20 | 40 0.029131 7.84
120E3 1.20 | 40 0.020391 7.84
120E4 1.20 | 30 0.024579 6.16
120E5 1.20 | 40 0.069914 7.84
120E6 1.20 | 40 0.058261 7.84
121 1.20 | 30 0.014366 6.16
121E 1.20 | 35 0.022813 6.94
121E1 1.20 | 20 0.004257 4.96
122 1.10 |75 0.460856 17.5
1221 1.10 | 75 0.172821 17.5
1222 1.10 |75 0.120975 17.5
1224 1.10 |75 0.120975 17.5
1225 1.10 | 80 0.146818 19.36
1228 1.10 |70 0.374693 15.76
123 1.10 | 40 0.02447 7.84
1231 1.10 |15 0.001845 4.54
1232 1.10 | 55 0.075728 11.26
1233 1.10 | 40 0.02916 7.84
123B 1.10 |25 0.008314 5.5
123B1 1.10 | 40 0.029131 7.84
123C 1.10 |55 0.047709 11.26
125 0.30 |50 0.045562 10
1312 042 |40 0.020391 7.84
1313 042 |40 0.058261 7.84
133A3 042 |55 0.108291 11.26
133B 042 |55 0.075728 11.26
133C1 042 |55 0.056796 11.26
1343 042 |40 0.023328 7.84
1351 042 |70 0.133953 15.76
1352 042 |40 0.049988 7.84
1353 042 |45 0.033215 8.86
1361 042 |10 0.000781 4.24
1362 042 |15 0.002636 4.54
1363 042 |15 0.001845 4.54
1365 042 |45 0.041518 8.86
1366 042 |25 0.008492 5.5
1367 042 |5 4.07E-05 4.06
1368 042 |35 0.055814 6.94
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140B2 0.75 |45 0.049772 8.86
140B3 0.75 |55 0.181748 11.26
140C1 0.75 |50 0.035844 10
140C2 0.75 |55 0.068155 11.26
140C3 0.75 |60 0.176969 12.64
140E1 0.75 |40 0.029131 7.84
140E2 0.75 |50 0.039827 10
141 0.75 |45 0.048487 8.86
143 0.75 |50 0.068343 10
143C 0.75 |55 0.068155 11.26
D011 1.00 | 10 0.004686 4.24
DO111 1.00 | 10 0.002609 4.24
DO0112 1.00 |25 0.016984 5.5
D013 1.00 |5 0.000163 4.06
D021 1.00 | 15 0.001834 4.54
D031 1.00 |5 0.000163 4.06
D032 1.00 |5 0.000163 4.06
D081 1.00 | 10 0.002609 4.24
D082 1.00 | 35 0.200929 6.94
D1010 1.00 |15 0.003669 4.54
D102 1.00 | 50 0.108698 10
D131 1.00 |5 0.000163 4.06
G061 1.00 | 15 0.002568 4.54
G062 1.00 |25 0.011889 55
G131 1.00 |15 0.003082 4.54
Gl61 1.00 | 15 0.002054 4.54
Gl62 1.00 |35 0.046883 6.94
S052 1.00 | 50 0.135873 10
S081 1.00 |45 0.087102 8.86
S091 1.00 | 60 0.154848 12.64
S0911 1.00 | 60 0.154848 12.64
S0912 1.00 | 70 0.421529 15.76
S0914 1.00 |55 0.088526 11.26
S092 1.00 | 70 0.295071 15.76
S093 1.00 |55 0.143126 11.26
S181 1.00 | 20 0.007811 4.96
S1811 1.00 | 60 0.253065 12.64
S1812 1.00 | 70 0.393427 15.76
S182 1.00 | 70 0.393427 15.76
S201 1.00 | 50 0.089611 10
S211 1.00 | 55 0.170389 11.26
S2810 1.00 | 50 0.170687 10
S301 1.00 | 40 0.045881 7.84
S3012 1.00 |45 0.065326 8.86
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VON 042 |10 0.003905 4.24
V111 042 |10 0.004686 4.24
CZ1 042 |15 0.002197 4.54
Cz2 1.00 | 60 0.073737 12.64
CZ3 1.00 |55 0.056796 11.26
CZ4 0.70 |55 0.075728 11.26
CZ5 1.00 |55 0.039757 11.26
CZ6 1.00 | 55 0.075728 11.26
Ccz7 1.00 | 65 0.09375 14.14
CZ8 1.00 |35 0.014636 6.94
CZ9 0.70 | 45 0.041477 8.86
CZ10 1.00 | 60 0.073737 12.64
Cz11 1.00 | 60 0.073737 12.64
CZ12 1.00 | 50 0.042672 10
CZ13 042 |45 0.059312 8.86
CZ14 1.00 |55 0.075728 11.26
CZ15 0.70 |50 0.056896 10
CZ16 0.70 | 45 0.041477 8.86
Ccz17 0.70 |15 0.001536 4.54
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